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SERUEARIEI BB 1-4 (5, A ExitiB .
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1.4 TEAER T HEIDxxx-QB-EZ ¥ 2%

1.4.1 R EME A

IDxxx-QB & NEC $2 (il fl, KW P &SP bug, MERFHATE R, ErTLL
X NEC HIZF CPU ALG AT, AR P4 T — METE. k. MR T— 1K Thie
CEpNIE GG =N

IDxxx-QB-EZ & H EZ/EM-1 AT VR4 AE, IDxxx-QB-EZ [ 2235 A S{E IDxxx-QB Z:3&
SEINZ JE A BEHEAT B T A SCHF Event A B AL, IDXxx-QB-EZ 1 IDxxx-QB 11T & A AHLL o

PN IR S 3R B B AR T R 2R P2 AN ] - IDxxx-QB 37 4 Minicube?2, IDxxx-QB-EZ 37 ¥ EZ/EM-1
P A
1.42 RSB

ASCLL 78K0 A, #A4E4Fk A ID78K0-QB Fil ID78K0-QB-EZ.

FHT EZIEM-1 () NEC 4= R 5 s il 2 (K R 28 R AE R 2 ik oAy

http://www.cn.necel.com/cn/Badge2007/debugger.html

HEH ID78K0-QB F1 ID78K0-QB-EZ ) f i hiA ~ %4, ID78K0-QB-EZ 1)1 ] A aiF
ID78K0-QB #1324, Faiseli)s, X ID78K0-QB I 4T E, HIFL Welcome % iFHE.

% Tool Installer

Taal
Tgols: Install. ..
Froduct Size
IDTBIG]—QB TEKD Integrated Debugger ¥3.00 23, 156EE
IDTEEO-HE ¥3.00 Documents 11, 260EE )
[]78ED IECUBE USE Driwer V1. 10 S7EE e
[J75K0 MINICUEE USE Driwer ¥1.10 SZEB
[CIMINICUBEZ USE Driwer ¥1.10 S2KB
MINICUEE Utility ¥W1.35 S16EE
MINICUEE Utility ¥1.35 Documents 5, ZTREE
Explaiz
DIrive: [
J}vailable
2,933, 354KE
Destination: Required
C:\HECTo0l=324T3ED Browse. . . i 40, 205KE

& 1-6  ID78K0-QB [1]%3& Welcome | ififE
s R 7 Browse ™ 14441, H5 & B2 B kA2, BRIAKAE L “C\NECTools32”, nJLIEFH
e B R i T AR, slitinstal™% 4], SR b B ILER R PATRINT o S8 S 53R
I EEI A A, S EXitiB .
AR T B 224 MINICUBE2 F1 MINICUBE HI3R3)), X BN 332 A+ NEC # LE QB-Mini
1 QB-Mini2 ffl. %F EZIEM-1 {EK5h, &S W 1.7 1.
SR JE Wt ID78K0-QB-EZ 11l #4047 3044,  HIIE Welcome X1 HE o

EZEM-1 455 T 5
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InstallShield Wizard

Preparing to Install...
ID7EE0-GE Setup is preparing the InstallShisld ‘wizard,

which will quide pou through the pragram setup process.
Pleaze wait.

Configuring ‘Windowes Installer

Cancel

K 1-7 ID78K0-QB-EZ [f]%:%% Welcome X} i fiE

mifi’Next 424117, HIL License X iHHE, AL AIIESE"Yes”, HZ A ReAh L 2ede, e
HA Ik FF " Typical”, RJGIEFE L3 H XA, BN R M e i, 5T BLsg
ID78K0-QB-EZ 1225 TAF .

1.4.3 FEHFHEK

75245 ID78K0-QB-EZ [ [A] I, 45 F 343 firmware update tool, #J F it T HLA] LAk EZ/EM-1
TR, FEERENE, EZEM-1BE BRI SH RREEE. 5% EZIEM-1 HTHER
IR HL, TR B EZIEM-1 55K 78K0S R A H A HL, W TR [ 4F
Bl 7T8K0S.

fi 1) BTN R

http://www.cn.necel.com/cn/Badge2007/modify2.html

AHIFAE R 78K0, i T > % > NEC Electronics Tools> ID78K0-QB-EZ >
firmware update tool”, E4IF FifIH sk A ) B 42 eIk b [ A1 fid e 1 H 5%, a4t 5 R Start ™4«
.

& QBEZUTL

Hex File:

[¥MGC hadee 2007%0CD_FWHBIT¥0CD_Fur

Start F.A er, I

EXIT

Kl 1-8 [l fE 6
WA E EZIEM-1 i fE AR E T USB i3 PC, N&4#H"Can not open Virtual UART
COM driver’ [/~ . i bz D485 PC L, WISFE R R I FL i .

6 EZEM-1 {5 2T/t
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QBEZUTL

SUCCESS
Fleazse exit this program and remove a USE cable.

B 1-9 [ T g E HE
F3"success " nE S5, N izt EZIEM-1 fEfFAT PC HLIVERRITF, R EHE L, 4
LLERASE . A" F RS> L >NEC Electronics Tools=>ID78K0-QB-EZ” HiT],

1.5 R T HWriteEZ[F) &3

1.5.1 4RfERSsafEiN

WriteEZ J&: NEC 2t g fEsctE, AT EZ/EM-1 st 28 5y hi g fe T2 . NEC Ll
i T B4 40 Minicube2. FP4. FP5 254847 & HBCE 144

WriteEZ #AFn] LI NEC [ 20 CPU Rt v ilfATgm A, v LA F P4t sl 7 P
bR, MEEERR, dnfd, KISEDhRE.

WriteEZ S A E A1) T Bud i -

http://www.cn.necel.com/en/Badge2007/flash _gui.html

EHETIHHOA A A RS PR RS, ARG 78K0, FrLA R #k WriteEZ3,

152 LIEIE

M A 9 NN TN G, ST G BE M H %, W c\program  files\NEC
ElectronicsTools\WriteEZ J&, B[l RJ 5¢ 2,

EZEM-1 $&2T/t 7
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1.6 BEIMEMSE IR

1.6.1 AR

W (Device File) JEA S s BB b SCfF . B — AN SO IR 7 — 3k
ARO[ RS

FEGR R P I R R, G TR BB A SO, SRS BN 1 AR R 25 77 885 R
It CATE 4 198 2 1T W6 2001 46 56 I 22 B 1 86 SUAE

7EH PM+ 4t F P I R rf, PMA+H R B 4 SO PF, R A3 B A e A R
1.6.2 SHEXHFEN

ZHCAT (Parameter File) & g A1 B 75 (1) SCRE SO, He 3= 22Dy ae @&k o i I ot
g 2% RS IR0 #8F, R 5 g R AR 8 5 B IE A R A7

e R, G R G B 7 S S HOCE, RAF BRI Fr 1) N A7 it TR S R
P AAEgmRE s VE 2 1, 208 S e e e S 500 A

NEC &Rl de Tl H IS BOCH A AT, RS S EOC T . WriteEZ F1 FP4
LA S Minicube2 fif H I ZHOC A4 AR, 462 PRM %2,

FP AT LLBBLR LR 205 AN R B0 i 1) e SCPE RS0 A

https://www5.necel.com/micro/tool_reg/OdsListTop.do?lang=en

1.6.3 &AL
NESER)E, EATRIEYG, RG S “TFE>FEF>NEC Electronics Tools>Device File

Installer”@]ﬁfﬂéﬁi, FTJT Device File Installer T E..

!\l Device File Installer o =] 24
Help |
Device File Package Inztall. .. I
About. .. |
Device File
Seurce Source |FECTEV. INI | rowse |
Tlevice Name | Vercion | Series | File Hame
l i

Mirwre | Rggisterl lr\Registe] I~ Delete Fil

age registered director}l

Begistr

Dewice HName | Verszion | Series | lirectory

< | i Exit

1-10 Device File Installer i
rithi"Browse &4, EPENIA iR H % % 30 (.78k) P12

8 EZEM-1 {5 2T/t
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LiDevice File Installer

- i RN
Dewice File Fackage In=tall. .. —J

5 fbhout. ..

Device File

Zouree Seurce ]D:\HCU\Install'\[levice_file\d:ﬂ rowse. .

Device Name

| Version | Serisz | File Hame
Ve 10 TEED  df054480. TSk
Ve 10 TEED 4054580 Tk
V2,10 TBKD 4054680, Tek
Ve 10 TEED  4f054780. TSk

[
i

Register InRegister [~ Delete Fi
Recizt: ige registered director}jf
Device Name | Version | Series | Direstory A
uPDTEF0S00_30 V2. 10 TEED C:“FECTOOLS3Z\TSEDVDEY
uPIITEFOS00_36 ¥z.10 TSED C: YHECTOOLS32\TSKOADEY
uPDTSFOS01_30 vz 10 TEED C:“FECTOOLS3Z\TSEDAIEY
uPDTEFOS01_36 V2. 10 TaKD C:\FECTOOLS3Z\TEED\DEY
uFIITEFOS02_30 ¥z, 10 TSED C: YHECTOOLS32\TSKOADEY
uPDTSFOS0Z_38 V2. 10 TEED C: “\FECTOOLS3Z\TSEDVIEY »
55 i | Fxit

B 111 R g is
TR F ik h— A2 AN 0. il Register 124, $4T 28, 8 K )71 Registered £
F BT 28002 v LA PM+SCRE 28 F
1.6.4 SECMHREE

SHCCAF I 22 I E i R 2 A T kAT

SR FEGEIG, e PATIR R4 . SRISIEAT WriteEZ3 A, 75 WriteEZ3 i | xS
ii"Device>Setup”, 7 Standard Fifi ii;"PRM File Read”, IEFEA7SHCIEI B4R DL Y
P Rits

FlashOper|

Dewice
Flash Open O Standard ]J\dvance]
72 Parameten
Success Rea T
3> LoadFile AT S
Success rea Parameter  TOFOS4TI. prm FEM File Read
>2COMMAYD: T - o
1L | eter file
Host conmection —  Supply escillater | FTD
Fort - Frequency |10.00 MHz
Speed Wiltiply 100 Load file-
14:01:06
~Operation Mode - 1
: Thart i. 00 - JEFFFL
& Chip to dewice
" Block End | 127 i
£ Area T Show Addre
[ Target Reset Messzage
we | mw ]
Ready NN |

1-12 Device File Installer F1fi
W AE Standard VU ) Parameter 7% %|"78F0547D.prm” 7 #f, I/~ 78K0 R 5

EZEM-1 $&2T/t 9
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UPD78F0547 [ 5% U225 52 ik o

B, A BRI SRR B g et e ke, B —ERAIN G —A NEC 78K0/KF2
0547D ) FH IR

1.7 EZ/EM-1 FJUSBIRZ 223

B K EZIEM-1 JE#:3] PC ML, S Esk2e3E USB Kzh, USB WKBhFREFRT N E M b in .
http://www.cn.necel.com/cn/Badge2007/flash gui.html

FEAZ LI N OB A K] USB JR3l), SR fif s A7 A H 3k
FE R EVHT IOREAT [ 7SI R IERE WS IR B e B2 (g (S) 7, RIa il 0,
TR RO E BN A USB SK AN P s IR A A7 T8 H 5%

RAFHELES
HERENR TN

@ LS FEFR EIEER G).

ERTRRIEEER R BEAESR - EEFHE TSR E. =R E
SRR DI

[(]#eserlisahiR & R, CI-ROM. .. ) o)
[V]FEtE s aE M B @)
| T2 \Driver \WTHZK v |

OFEEF. BEACEEEHIENEF 0.

BEEEE-TE LB W B PR S OE=DR2F - Windows -THERIEERRIEZERIIE
iz SIERE e L.

(IZfe|f-2w> [ BE |

1-13 7€ USB YR H %
2L J LB ) PR G, 29 ARERTAE, SRz ksl E A il Windows bR, 1t
I3 S AR ARELE (C) 7o BWIMIEILSE O] USB BKa) 2%k .

sk

) E IETE AR R g gk 1

L3
KEC Electronics Starter Kit Wirtual UART
B Windpws\ﬁﬁﬁiﬂﬂﬁ; f;ﬁsﬁ&fﬁ Window=s XP
RIS (EFRAT A IHRER. )

fETREHYRA SRR RRES AR,
Nicrosoft HRENEBILHYE » HAWHItER
EER » ELEEHIEY Yindows SHEMEAEE.

[ mREEo | ]

1-14  FERIRIE I (KL
USB 9K 5) 2358 in 27 2 R Fri -

10 EZEM-1 f7 5Tl
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W1 PR TR 2

BAFMBELH RS
FERIRBIFHEA S

=

EEEEETR T TR SRS
3 FEC Electronics Starter Kit Virtual UART

EXHER , F8E “FEE" -

Kl 1-15  USB 9Kl Zeke se i A i
XA EZ/IEM-1 1) USB B 5)) 25 TAR M 5E 1 T o

EZEM-1 55T
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H2E Az RN

2.1 HEEHIHE

YOIRE L AR an AT ] EZ/IEM-1 AT BT &, NEC HLF 1) MCU AT & T 32 4
Applilet, PM+, IDxxx-QB #il WriteEZ %% .

ASEHI LA 5 42 78KO/KF2 411 1 PD78F0547D. %% T/t (78KO/KF2 8 £ #.
Fr A EIEE P F) (U17397CASVOUD),  BLRTFZS I E 245 B o B2 IRl ARS 1) A 7
BLAE ] Applilet2 for 78KOKx2 V2.10 LL EfRAS, ZikTH4E PM+ V6.30 LA LA, ik Demo 774
ID78K0-QB V3.00 LA LJiAs, giftles i L4l H WriteEZ3 V1.10 5k FP5 V2.01 BL ERicA .

YA AR AR T B AL E EZ/IEM-1 DL 7= il erh B (1) USB 44k 8 £HHELk, AMEZ
HAsR G A58 4 PD78F0547D).

HoAth B 5 Mz B 2o 6 B 1 Applilet 7T LL3 4T B4R 2«

http://www.cn.necel.com/micro/cn/product/sc/applilet/applilet-freesoft.html

2.2 IRFHARAG I A Ak

2.2.1  Applilet2 (a3
iR, A Applilet (N RS, sSdi?File > New”, HIHL R X iEHE,

Applilet? Wizard

Stepl-Project zeting e
Thiz step will set the basic information about the " LSS LASH
Applilet? project.

A

Project setting

##1. Froject Setti
* Project Name : [EZEM e

2. Select Compil
% Project Path : [D:\testiEZEMY) St

3. Select EIOS

Select Dewice

4. RTOE Setting

Series FHame Chip Hame :
]TSIG:I,-’KFZ LJ |uPDTSFDS4T_BD ﬂ 5. Confirmation

| Hext » ‘ Cancel | Help |

B 2-1 7t Applilet2 fiiff H o5t
Kl 2-1 i 11)"Project name” AL nT L w44, O T IXHIANFEIK TRE, @ AT Ee, LB

12 EZEM-1 f7 5Tl
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92 mONHRNE

1 EZIEM-1.

AR TRAT T B o 78KO/KF2 £:4111) UPD78F0547, a5k 2 S5 F 4 FH 1) H Frdi 1)
ERI g TS . DR AUS, AINEXT S 4], 25w E S, ALy DAk A 1
CiEE MBI i S5 AEARTREBREF T, EH C S XN CC78K0 4nis.

“>Applilet2 for 78KO/Kx2 - [D:\test\EZEM\EZEM.przl  [Z]E]X

File FPeripheral Optionz Help

EHE > EE % 7 0 & @A cCrEK Compiler -

Fin | I . — - :
3 3Save the configured project|
Feripheral s N R e

E ﬂ Feripheral pevay
) System ﬁ System @ Fort ]‘_N‘I‘ g IRT
(P Fort “ANT

g LHE AfD Serial Times

P Serial

(P Timer : 'I'atc]ulng Timer @ Tatch Timer '[3 Clock Output
@ Watchdeg Timer ) o

0 Watch Timer
50 Clock Cutput
&P 1V

L¥YI

NECTSKOKF2: wPDT8F0647_%0 | fprs: SMHz|frl: 240KHz|fsub: DKHz
Kl 2-2 Applilet2 [ 3 F i
TN AL B RGBFNE [ IR,  ERHERR FHE  P9E 1 8MHz [ 8

Clock setting ]Un—chip debug settingi Power-on—Clear settingi

Main system clock selection - - - -
—High-speed internal oscillator setting

f* High-zpeed internal [# Dperation
escillator Frenquency MHz) {8 LJ

—High-speed system clock setting
' Operation

" High-speed system clock (% %1 s=pillatior " Fxternal clock put
Stable time (ns) [13.11 @186 =]

Frenqueney (MHz) | -

Sub-clock mode
{* lUnuzed 7 ¥T1 ozeillation (" External clock input

Sub-clock (FHz) 2 ThE ¥

CFV and peripheral clack setting
CPU clock (KHz) [4000 (£xp/2) |
=l

Feripheral clock(MHz) {B [frh)

Low—speed internal oscillater setting

|V Can be stopped by software (Option byte) [~ Stop
Low-zpeed internal oseillator (BHz) J24D .LJ
Defanlt | Infa |

2-3  7£ Applilet2 # & i b
7£1% 7T FF”Low-Speed Internal Oscillator Setting” 3% # v] DL i #4445 1= "can be stopped
by software(Option byte)”. X#{£4 w LLF-3)){5 11- watchdog ##:4E, LA (i1

EZEM-1 $&2T/t 13
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Hatchdog Timer

—Mode

(™ TUsed f+ Trmsed

—Llock zelection

Overflow time(ms) r 15 (131072 frl _;J

—Hindow opening

Hindow opening time (%) ] 10 _]
Default | Infa ] Help

Kl 2-4 7F Applilet2 T EH 11

X]

System

Clock setting On-chip debug setting 1Power—on—Clear settingi

—On-chip debug setting

7 Unused & Uszed

—Pin setting - —BAM monitor setting
{+ 0OCDO&, OCDOB & Unused

" OCDLA, OCDLE " Used

Security ID authentication failure setting

(" Do mot erase flash memory data

{* Eraze flazh memory data |

—SECUEITY ID setting
[~ Use SECURITY ID
SECURITY ID

Default | Info ‘ [H)id ‘ Cancel ‘ Help |

K 2-5 7¢ Applilet % & EIFEIR
AL N Z AT TR —3%, {E”On-chip debug setting”#r%s T & rh”"Used”f# g F LK)
fig, ATRALE AT (A PC oM S el e o H AR I F P B is AT I VR4 N 45
i AE Applilet %A T JT OCD IhfE, 78 PM+A R P4 i e i R it [l i, {HJE7E
ID78K0-QB-EZ 1 F AN st 2x H B 1 (1 1%

14 EZEM-1 § T}



VID78K0-0B

=
File Edit Wew Option Bun Event Browse Jump  MWindow  Help
I

Stop

[

1
Gio

-
ReGo

rs

»>
Gio

-
Ret

»
Step

ID78K0-QB x|

' FOc33: Disabling the on-chip debug Function is prohibited.
ud 5 :

L]

Crer

Fe= Open | Load Pr_

Kl 2-6 At OCD Mg s BULIEHEN a4
WERBATTIT OCD Thfig, A2 thn] A g A e e 07 R e 4 38 i A2 ) Hex STIFELEE T
B HAx MCU 17, HZTE . W2 AREMT] ID78K0-QB-EZ sl A i - )\ PC L
KMEREFKEAT, AT AT B

222 VapIREFFMER

DA R IREEA R B SE i, T ORI E R ATV IR P R e T . JEWIRE Y I D RE 2 2 H1
Fbst L B4~ LED AT BL 2Hz 4358 KIN .

a) W LED (58, 5 28 M 1 5SRO i i, P DARE SEACE Port BEHORE il 1 5

b) FEMINERIIA, LB B I8 h WK Rl bR, B LU 220 Timer BB 5E I 4% 5

c) HMPCHL LR, FiH] OCD Lifig. iXAR > AL E C4AE)H 3 Applilet I 58 .

HER: OCD IhREE R HARMR_LIK MCU N2 #F OCD AR INAEN D R4S (3 Debug THAEMIERIIARAS),
it OCD WEE FH A RAMBE LR, 76 78K0S RIIFHIEHIRRH RIZAEZHE. BT 78KO0 Rt
ISR, PIEER 4 PD78F0544, 4 PD78F0545, u PD78F0546, 4 PD78F0547 VUskigdsHsekIF R,
T R% %48 Fl 1 PD78F0547D KA 4 88 K 1R

2.2.3 PortiyiE

WA R, fEIE 2-2 RIPPORT RG], #iB 21 F EIBCE Fhimm.  HArb B i m
A LED ¥R 205 Fr 1 PD78F0547 () P60, P61 MM 11,

EZEM-1 $8 SF it 15
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Port E|

Fortld |
Fort0 |Portl |Part? |Portd |Portd |Ports Fortd ]Port'r | Pore1z | Bore1a |
- PEQ

" Unused " In (* Out v 1 [ Change I/0 by software

P61

" Vnused " In @ Out [ 1 [ Change I/0 by software

“TBZ

@ Unused " In O Out [ [~ Change I/0 by software
—FEa

& rmsed iy " Dut JEiil |~ Change I/0 by software

PG4 —

® Urused  In (" Out [ Pull-up [ [ Change I/0 by =zoftware
—PES

% Urmsed In Ot [ Poll-up [ | [~ Change I/0 by zoftware
PEE

f¢ lnmsed { Iq " Out [ Pull-up I 81 [ Change I/0 by software
—PBT

¢ Unused (" In o Ouwt [ Pull-uwp [ [~ Change I/0 by software

Default | Info J 0K ‘ Canecel J Help ‘

2-7 Applilet2 [¥] Port 11 & 51
WE Port WA, WA ZANThRen KR o 880, nlRes KA nhse, G R
JP RIS M I B AT R

2.2.4 Timerf{i &

Applilet2 B4 Timer S ) v & an N IR, h iR WL, A8 2 2 48 TMOO fx i
{1 Interval Zhfg.
THOD ]Tmm ] THSOD ] THS1 ] THHD ] THHL ]

Functions

Unmsed

FPi output

Fulse width measurement

Square—wawe output

"
i«
i
L
(" External ewent counter
&
(" One-shot pulze ocutput
"

Free—rumning timer

Tetail J Default‘ Infa I 0K J Cancel I Help I

& 2-8 Applilet [ Timer ftR 1 & ST

16 EZEM-1 4§ 5 Tt
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%)

THOO interval timer setting
Cloclk mode =elect : -
Internal clock
¢ Internal cleck
HALE R o (* Auto " fprs

" fpr=f2’2 ™ fpr=/2°8
O Etevnal el aels —External clocls

T
£ TION

Interwval walue setting

Interwval walue ]SDD 1M -

(hetual walue: S00)

Interrupt setting
v TMOO and CROO0 match, generate an interrupt (CHTTMOOO)

Priority lLow LJ

Dafanlt ‘ Infa | 0K I Cancel ‘ Help |

K12-9 Applilet [ Timer ({45 1 & Stk
KA A%k 2Hz, BT LA KIS E] 6 Bk 500 msec. 404 528 500 msec 1) LA JEvEI 44k
HYEHEUE, 7E"Count Clock F2ik#f H AR W] o 71 H By i 75 2 40 3o 1 (1) = (G HESRAS, P A
L R KT B ()" TMOO and CR000 match, generate a interrupt”.

225 AR

FE e e PR P e ok, W R AT SRl TR SR B i DI RE, 1 Z AT
LA EDUASBER BB e i, P ARSI HES A A BE . 58 1o
SR ESENZ G, i Applilet FE SRR A "GO 441 5 # "File> Generate Source
Code”, JLHEAN T 40T AR P A2 BORT 3 J 1 -
Generate Source Code &|

—Generated files and functions -

[P System Expand all
@ INT
&P PORT
£ AD Collapse all
£ Serial
A Timer
@ WatchTimer
7 WatchdagTimer
@ Clockiut
4 LYl

- - - E-E-E-E-E

Changze Folder

Generate

Cloze

The generating sowrce folder is: D:htest\EZEM\

2-10 Applilet FLESCAEH A ik
miA N U0 Generate ™ $ AL UG A AR 7 AT A6 AE TS B2 E M 42 o 58 G 22 3 H 7 11 4]

EZEM-1 $8 SF it 17
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HH T 202 K SO L AP T

Generate begining:

2-11  Applilet F2 ¥ SO A2 5k

2.3 RiEE. k.

] Applilet2 T HAAA R 7 302 5, T T DA PM+ B3N AR B TR SCAF,
BRAEWR

M PM+ $TIFLRESCH; EZEM.prwe TIERANEZE— AT IF PM+, JIBAERIA 2 AZhITIF E—k
KM PM+I IEAL T ARSI CRE S

FEFTTF % TRERT, AT 82338 2 G R 28 R R 28 X N IRCA (R OGH G HE , 17 At T 77 " detail setting”
KiE, EH"ID78K0-QB-EZ 4 (1)"V3.00", 15 NI /E IR 2% i B I vk EZ/EM-1 173K 5% .

TXRE TG A3 22 Tl R A 11 4 1F 8 FH R 28 R EA T T K o

Tool ¥ersion Settings

Tool Set

TG0 Software Fackage ¥4.00 (Enslich Version) 3 __;i;;;__J e
Tool Yersions @

Toal | Yersion _ Thet:ﬂld\vhlilﬁ 1; n:tnl

ins ed wi e Loo,

COTRED 4 00 i=pecified by the zelected
EATEED 4. 00 tool =zet iz dizplayed in the
SKTSED ¥3.00 | ay.

IDTSKI-0B ¥3.00

IDT3KI-QB-EL Hntesd

S for TEHD ve.ed

BSTAED V.00

Select only Installed Tool

[ Select only Installed Tecls tail Setting_‘ 0K | Cancel J Help

K 2-12  JH PM+4TJT LR
T HTEGHARREW R, T PM+ MEAENSE, FREAE 5 &,

18 EZEM-1 f7 5Tl



File Edit Find Layer Uiew Project Build Tool UYindow Help

|2-De @SR sl R =« ++ -|[=

J |hpplilet ~ 78k Series

= |[Debug Build

sl R

A @

ZProjectWindow |:HE]® mD:\test\EZEHIOORHB\main. c

B

T8k Series : 1 Project(s)

-@ Applilet
£ 3 Seurcs Files - void main{ void )+

- 4
while (1) {+
i

7B timer.

- [E] TIMER_user. o
# watchdogtimer. ¢
option. asm

watchdogtimer h
option ine

(= 23 Froject Related Files

/% TODO. add user code

il g

For Help, press Fl

2-13

M PM+4TIT 18

UETRER, 4 Applilet £ K AU RE P IVIREHESE, 30 /5 25450 — i A SRS
A R T RE I 28, SIS AR -

W D:\test \EZEH100

**  Noned

= ***
— * %
_ w4

— woid main{ wvoid ) ¥

=

— while(1){¥
- iy

= }+ e
_}+ e
_* e
- [ECF] -

ral B
|« 3P K

LRGN THO0 Scart | void ) [

R4
¥
Fis
FF_
g
Exs
%
wEy
£+

H

ClrIOREit (MEOD,
THCOO = Ox0c;

A+ INTTHMOOO e:
/* interval timer

0xz0j ;

ibstract:¥

This function can stop the THOO counter at

Parameters:
Hone

""" JI

v 4

2-14 7 main E % 5 3) TM0OO
1E BRSO main.c () s E0h A INiE )" TMOO0_Start (O "iZiEA) IAVE T L RE 2 I 2% . %

TEAY A B N 1Z%AE while JEFRE )2 BT .

SRIGAEE I HF R4S F 7 (Interrupt Service Route) Hs i H S 14865, ik LED TN,

ik P60 H1 P61 i I e i IR A

EZEM-1 $55 Tl
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BD:\test\EZEM\Timer user.c

"
_ interrupt wvoid MD_INTTHOOO( woid 1%

A% 3tart user code. Do not edit comment generated here */4

Fe.1='Fo.1:
/% End user code. Do not edit comment generated here #/4

T

% Start adding user code. Do not edit conment generated here */4
/% End user code adding. Do not edit comwent generated here */ 4

¥

*

[ECF]

-

4| 2z
K 2-15 7& ISR His i B s
TE A BN E N2 TMOO o 3 ) o 7 IR 45 A5 1 vh ‘5 AT AR B AT o 480 i) A 4524 ”P6.0=1P6.0;
P6.1=IP6.1; "tk & 45k 500 EFB I F], =A@ i, ¥ P6.0 F1 P6.1 FPRASEUR, XA (1)
BB H AR _E 20T st k] 52K
DA Ay A5 2% Applilet2 A2 s AR 7 SCAF A TAE S it AR R A 4 55 5 T o

EBEN PM+ I8, WER O BCE TN IR, S b I as B bR, Rl 2
WA B 1% &, sii"Tool > Debugger Settings”, i #%”"ID78K0-QB-EZ V3.00 Integrated
Debugger"fE ik #5 . ¥ 5 Debug Target NiZ 5 O Imf S0, AZEERE Hex SCfF. W EH
FRBIILLEIR, 151 1.4 D BT IR .

oA 2 HC8 I TG 75 S0 8, P A B R g VR I L OB SE I, P L R "ReBuild” 5L
#”Build and Debug” 1% B[ 7]

Debugger Settings E|

Select

i,

Debugger: ITEE0-OB V3 00 TSR0 Integrated Debuzzer

File IC:\NECToolsSZ\TSKD\IDTSKD-QB\HG.DD\BIN\IDKD32G.E}

Option: I

Debug Target
Debugz Target
D:4test \EZEMY 2. hex ]
[¥ Exacute Swvmb
¥ Execute CPU Rezet after Download

Debgg

0K | Cancel ‘ Help
2-16 LEFEXT IV AR kA

2 EZEM-1 4§ 5 Tl
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W EH PR A TFREN, BagmEErEiE, waes BV RIRE, 2R
PR TE S, HEBIE 2 Build Ih S

PMplus x|

L.
\ql{) 13500 Build completed normally.

] 2-17 Build %3
2.4 FEFRBATAER
2.4.1 J331D78K0-QB-EZ

miiti PM+ H1)"Build >Build and Debug”, 55371 PM+Ftifii 4% ~ F5 8, #nl LA7Egn o
HE H 34T IT ID78K0-QB-EZ 14/ . "Chip™# 4 I HRAS o PIAZ A28 A 3 O 4 i AT
1) NEC A, ArLAas¥s S b A shBie o PM+ T REH (05 2R

5 PM+ ARG 0L, el LN IF 45 > B 5 #£ ¥ > NEC Electronics Tools—>
ID78K0-QB-EZ-> ID78K0-QB-EZ V3.00"4] FFi% ik ffo ULI"Chip# 8 H HHIGERRA, TEIRHET 4
VAR TR R A B o SR N R AE BRI 78F0547 [RIET, B W8 F I & ST
WA S, @&, BAIES% 1.5 15,

I EZIEM-1 IILL O dR T i, R N ECIRAS .

Configuration

Chip i
e [

Cancel
Internal ROM/RAM

Eestore

Internal it “| KBytes -
Froject. ..
¥ Use & = e About. ..
Internal high-speed 124 “| Bwte: Help
—ID Code
Internal Extend it ¥ | Bytes bk ok ok bk kb bk
Main Clock
{ Clock E {7 Externa {* System 4.00 - | MHz
(" Clock Boar: 00 Externae 0 2 3
Peripheral Ereal Monitor Clock -Target Fower Off P = Breal
{" Break f* System 7 Permit
(+ Hon Break (™ User % Hot Fermit :
Mazk
[~ HAT I TARGET RESET I INTERMAL RESET [ HiI
2 Memory Happi.ng
Memory Mapping hdd
|Target j J T Delete

K 2-18 HFr:OH HIEFE
RPN E R, ARy EZIEM-1 F1 PC Z IR USB &£ BT . ik USB %4k
5 PCHLR# L, LM USB i#2ks EZIEM-1 2[R FERR L .

EZEM-1 $&2T/t 21



ID78K0-QB-EZ

': F0100: Can not communicate with ICE. Please confirm the installation of the device driver
for the FC interface board.

’2-19 D Ji 3hAt i S iii—USB #:4k
QR I N, 2R EZIEM-1 R E AR ) R A ek, A T REE A
EZ/EM-1 JG I T AT A IR o V42 R i B PR, 2 1 ks A AR AR (I 3215 DL LA S EZIEM-1 (1)
TR E . ABIFE 78K0, B LMX T 8 ML 3t il LA LRk

IDT8KO-QB-EZ

Q A01a0: No response from the CFU. Please confirm the signal of the CLOCE or EESET, WAIT and

S0 0o

K 2-20 ID JEshEE RS - B AR
WS I R, A PR Wi RIE R B ARA H YR B EZIEM-1 $E, A8 A AT AT RE LA
%Hﬁﬁ&ﬁm%ﬁ%;m%aﬁﬁ%%%%gﬁﬁ,%ZT%%I%HHW&HE%L%O

ID78K0-0B e

' ': FO3al: Target is nok kurned on.

K 2-21 1D jBshd RS - BARBCREEH L
242 PR
JA%) ID78K0-QB-EZ J&, nR—UIiAl, Wjss HELMIRIHE, ) in) A& 75 5 2N B A b s
(EZIEM.Imf), EF"Yes [Fl= )G, nlLIE R NS W R
D78K0S—QB-EZ

2 Edit Wiew Option Bun Ewvent mp Waindow Hel

_|_|-I-' I*IHI*HI*I @IEJII @jwﬂ;a@i Qlal#2)

Downl oad

D:'test \EZEMI00RNMEVEZEN. 1nf
object: loading...

K 2-22 ID78K0-QB-EZ (1 4 i1
NEARE R A TR EL 3 RPN TA], G R LR, R 2 IR IR TR gk S
— A N EGEBUE BT DUE B R S, a R B BRX S, E TSR SO, A
PR SR ROE A s A — A G RS, BT BLUACK & IEAEE N T R .

22 EZEM-1 {5 2T/t
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55 IDTSKOS-QB-EZ : EZEN. prj

i
Elle Ech.t Vlaw Option Ru.n Event Bruwse lump ¥indow Help

[ L I e e 5
Stop |ReGa| w0 | oo + | Step | Over L em Wch Reg | =FR

| €| > | Mateh | gmick

]
i/
“

Rbstract:
Thiz function inplenents nain funct ion.

Paraneters:
0ne

Returns:
Hona

il
nid nainl void 1

ST000. add user code *
THOD Start(1;

vhile(1){

& 2-23 ID78K0-QB-EZ f&/718 1T 51
W RAERE P AT BEE W A, W A BB S R 424 "ReGO”, "GO Hi#E"GO-N", FiF
THGAHIEAT o FEPAL TISATIRASIN, AR A PR E LU0, BN EZ/EM-1 1)4-4T (Run)
55, [FINLTAT (Break) #EK.

25 BEFHFMERS

FERE P B AR 58 i 5 5 H AR HUIZ AT I, Bl 7 7 2R R e AU be S 1) H ARBR 1 i)t
Jr AT, AT RUME ] EZ/EM-1 4R R BE -

25.1  E#IWriteEZ3

1F WriteEZ3 (12355 H 5% F Xl WriteEZ3.exe, #tn] LL$TFF WriteEZ3 #fF: .

EWriteEZ3

File Dewice TView Help

Tevice

:Name :
> ParameterFile Reading. ...
Success Read ParameterFile. | Firm
¥ LoadFile Reading. ... | ExtCode :
Success read HEX file. A
— Farameter file-
| Hame : TAFOS4TD
| Format 0414

| ¥ersion ¥i.04
| Processor 0200

s ~Load file |
| Hame & HEX

| Date : 2008/08/25 16:57:24

| Chksum D25Ch

[frea  O0000Oh-OIFFFFL |
Conmection to dewice-;
| Fort COM4

| Speed 115200

| Bange Chip

| Freq. 85.00

[Multipl 1.00

K| 2-24 1D78K0-QB-EZ &) Fiz4T Htifi
¥ EZIEM-1 Fil PC HLLL K H bR IEMf&E e 5, sl DAt Tk E . EEP SRS T 250C

EZEM-1 $&2T/t 23
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PERAGERERCE . HARN HARBUEREA EZIEM-1 [IJF R EIE S WA 6 5.

25.2 HfERTE
BB ER S, FRME 8 & AR & B WriteEZ3 ek, SRJEwinl LAgE T . gnfe
SEE, WriteEZ3 £ 4F 1= 11 2 1151 AT 1 00

EWriteEZ3

File Dewice ¥iew Help

UK 94

FCOMMARD : AutoProcedure (Epw) I Dewice
Flash Blank Checking. . . | Hame DTSF0S4T

not blanls, then erase.

Flazh Erasing .. | Firm 2 00

chip erase finish. | FxtCode ° TFO4TCh

Flash Programming Start, .. Vandor 10k
Flazh Programming <10%> .. = -

Flash Programming <20%> .. e netergbrle

| Hame : TEFOS4TD

Flash Programming <30%>. .. |
Flazh Programming <40%> .. Form_at Datd
: Yerzion ¥1.04

Flash Programming <50%>. .. P 0200

Flash Programming <BO%>. .. I ChEET i _

Flash Programming <TO%> .. Load file

Flash Programming <B0%>. .. | Hame & HEX

Flash Programming <90%> .. | Date : 20058/08/25 16:57:24
Chk=um D25Ch

| Area  000000R-01FFEFh
Conmection to dewice

| Fort COMS

| Speed 115200

| Range Chip

| Freq. &.00

Multipl 1.00 |

I
Feady HUN

K| 2-25 ID78K0-QB-EZ &) Fiz4T it
HEZFIK 100%)5, & 2 IL"Flash Programming finish ! "“74%, MRS AR 52 T
B W

24 EZEM-1 f7 5Tl



5 3 @ NEC Tools JT &K HEE i/

%3 NEC ToolsFF & i

A TR EA A F M P 2% NEC Tools k& T H. .

3.1 Mk

NEC Tools FF R EA S T NEC RAIMIEHIZE (MCU) FFRFTTHZM LM TR, Wikshis
AR TR, gk THE, s T H, K T A,

AT WK AE S5 T ) F T VEAN A 44 A T 78K0 %41 MCU ) NEC JFk T H, I ik sy
AT H Applilet2, £ dn iF 3855 PM+. 8803455 ID78K0-QB.

3.2 Céui¥ss CC78KO

‘2HReSe)E, CC78K0 S El PM+F-Grf, I ATLMER] PM+ 4% TR, Bl LU RAE
CC78KO i AT 75 A\ TRE, (HIXA 7 s B AR
CC78KO i N C ¥isCt, g kA il g SCAF BRSO

CC78KO i NS AL
file.c C At

CC78KO ¥t SC At
file.asm - gmdF S
R A

.C YA .asm YL 4w 30

v

CC78KXx

K 3-1 CC78K0 T Ak~

3.3 L4328 RA78KO

WHGE)G, RAT8KO £ERE] PM+ &, R nfLMEH PM+4ik TR, i n] LA HAd H
RA78KO [ ir AT 77 it T, AHX R 7 R R 22 o
RA78KO B NI Zwdi SCF, gt H AR SCAFRIBI R SO, HEBe Al aE e T e )5,
A ELIE A H AR SO v (1 BORNAS SEAE AT 1 RO o
RA78KO [ A\ S5«
file.asm WG 3L

RA78Kx ¥4 i SO 4
file.rel H sk
file.prn FZ A

EZEM-1 5 SF M 25
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.asm A .rEﬁ/ﬁ\IﬁE
)

RA78Kx >

\ N
prn F1 At

Y
]

K 3-2 RA78K0 T /EriEE

3.4 RS LK78KX

LK78Kx L& E] PM+F- &, H7nr DUMEAH PM+#E4E TR . tn] DLE AT LK78Kx 1)
AT 7 NG e TR, (IR Oy IR R %

—MAEBL T, PR 2 /NSO G ] CC78KO0 Fil RA78KO A S b BELL S, 4
AR A bR Set: Crel), HARSCHE i B FIAR Bk I ) BUERf € « MU LK78Kx 31T 45%
e, SN RAT I ClmE).

B TR SCPF, LK78Kx fEREH R ik T B N B #4230 fF (Directive file, ¥ J#4.dr,
DASKEL Bt ik RN/ B T B N4 0P (Device file, 37 44.78k), LIIRAFH Ik A7 ge Al
FNAEE R R E S (Library file, #7 B4 lib), LASRAFIER BT,

LK78Kx i A A4 45 :

file.rel H bR A
file.dr Bk Rz A
file.78k WA S
file.lib PESCAE
LK78Kx )4 Hh SC B :
file.Imf A PAT RIS A T
- Amf AT A
rel Hix

Lk78Kx

72l

el HbnsetE  dr BUeEE o 78K W& etF  lib J3ESC

U8 0 E

K 3-3 LK78Kx T/EREE

»
>

26 EZEM-1 8 F



3.5 HBIXHEHEE OC78Kx
FH P ] L OCT78Kx KAk nf $iATRE e Clme) k2 h n $idT SeA e Chex), JfH.
AT LU A S RS0 Csym)e — Bk Ut, 78 PM+f il Build, 5] LL5E % OC78Kx [k .
OC78Kx LT hex Frifikg=L: Intel 5K .

OC78Kx i NS4 :
file.Imf AlPAT BB S
OCT78Kx % H SR $5 :
file.hex ATPAT SCAR A
file.sym g R At
Amf H AR S0k hex HbrcE
| OC78Kx \ >
sym fif 5 R 3T

K 3-4 OC78Kx TAFrEE

3.6 FEAES LB78Kx

LB78Kx D4t A 2] PM+F-arr, P n] DAL 24T 77 N EHMH LB78Kx Kok A ik
IS Crel) 8 4 FE SO
LB78Kx 4 A ST A4 «
file.rel H br S
LB78Kx [y H ST A4«
file.lib S AT

el Har etk lib g3 ft

rel Eﬁiﬁﬁ/

LB78Kx

3-5 LB78Kx L{EnEH

EZEM-1 5 SF /M 27



o4 IKEhARRYAE T H Applilet

FA4E EEhARESAE R T R Applilet2

AFES4] Applilet2 SXEN A A S T H, 3l AR S, ] LU 3 A E EAR BT it 22 e

Lhie, WRUEEIEI R E S A, W R P IS, U ZA > BB L SRR A
R C ARSI A . T A JEEE T B b A Ok, AN 5 S S ORI TR 2%

TR — AT R AR A T
AR v A FH ) 2 Applilet2 for 78KOKx2 V2.41, 4T NEC 78K0/KX2 R4l ge.

4.1 JAzhApplilet2

A TGS BT B> NEC Electronics Tools=>Applilet2 for 78KOKx2” & br & , HHTAY
TR JERE A0 e, R4 e QR i -

>Applilet? for 78KO/Kx2 — [D:\test\EZEM\EZEM.prxl [C|B|X]

File Peripheral Optionz Help

E”v P B E %7 0 E @ coTsk Copiler -

. 1 1 [
ﬁ::iphe]rilSave the configured project

[=] 'ﬂPeripheral e

7 System s System @ Port ]:NTE INT

P Fort SANT

() IHT =

B WD AD ?7 Serial Timer

(P Serial

g ;m:e;d i 'I'al_chdog Timer @ Tatch Timer 'rjl Clock Output
atechdog Timer ) A

P Wateh Timer

£ Clock Output L¥YI

P LI

NECTSKOKFZ: wFDTEFO54T &0 | fprz: &MHz|frl: 240KHz|faub: OKHz

K 4-1  Applilet2 3= 7t

4.2 ThEeStmE

riii"File>New” 31 i Applilet Wizard, 7EIbAb$e el H 4RI H A5 H 3%, JHERRT T
(1B 2 AF o
NG S e RIS, B e NI B RGN TR A [ AR
FHT Marco (ETEAT T, il 2-2 Prox, Hrp Macro #8225 MCU AR A BT %
5o
FH P AT LAAE"Func™ i SUW AR K bR BHEZL, T AR I S THD b S50 0t . (1) 75 A7 3 1E 4l i
L, W R EFTR:

28 EZEM-1 8 F



o4 IKEhARRYAE T H Applilet

Applilet2 for 78KO/Kx2 — :\test \EZEM\EZEM. prx]
File [Peripheral Options Help
BeE 2 BE % F 0 @ @9 K Compiler -
Bn |1k |mmo | I * [T
Feriphersl | Menory Fumction ] g EEEI'
b
P Systen ++ This device driver was created by Applilet2 for 76HD/Ex2 1 Q i
= % 3_Bit Single-Chip Microcontrollers
g Clock_Init e —
* # CG_ChangeFrequancy #+*  Copyrighti(C) MEC Electronics Corporation 2002 - 2008 NL;
- @ CG_SelectPowerSaveMode [|n A1l rights reserved by NEC Electronics Corporation. -
*  06_ChangeClockMode ki
- @ CG_SelectStabTine #* This program should be used on your own responsibility.
[ System_user. e +* MNEC Electronics Corporationm assumes no responsibility for any losses
‘[ Systen.h ** incurred by customers or third parties arising from the use of this fi. ﬁ@
+-(f IFT s
¢ PORT ++ Filemame : System.c
(P AD ** Ahstract : This file iwplements device driwver for System module.
D@ sl :: APIlib :  AppliletZ for 7SK0/Ex2 V2.4l [29 Apr. 2008]
el £ Tiner =r Device : WPDTEFO547 &0 a
# (P WatchTiner e =
* (P WatehdogTiner 5 aien: BN @
(P Clecklut B
# P LT #t  Creation date: 2008-8-25 @!j
b L
E @
i P ¥
| &5 < | >
| NECTSKOKF2: uPDTEFOS47_80 | fprs: 8MHz|frl: 240KHz|fsub: OKHz

% 4-2  Applilet [f] Func Fifi
ALl Applilet2 1"Pin"FR%8 GRS BT 5 R, DL e I ot s, Lhin
Ok i P60, P61 i AL At 1118 EIAR Tom AN\, a0 BT s

pplilet2 for 78K0/Kx2 - \test \EZEM\EZEN. prx]
File Peripheral Options Help
B HE 9 BE & 7 08 @ 9 cCTE Conpiler -
Peripheral | Memory | Function | Alias | Hame | Fametions [Status | T/0 | Deseriptia
Pin  |mr  |or | P25 P25/ ANIS free W
P26 P26/ ANTE free
(P System ~ 2T FET/RHIT s
+ £ IHT PO F30/INTEL free
<P FOET 3L F3L/THTEZ free
- Faz F32/INTES free
:' g 1;”“? 33 Pa3/THTP4/TIS1/T051 fres
e ot B0 B0 free
+-ff FortZ P4l P4l free
@ Portd P42 P42 fres
@ Portd P43 P43 free
@ Ports P44 P44 free
* P45 P45 free
=l Portf P46 P46 free
: B4T F4T free
P50 S0 free
51 51 free
P52 P52 free
P53 P53 frae =
P54 P54 free
P55 PS5 free
P56 ] free
P57 P57 free
: 50 FBO/SCID 0] /o
(i Fortd = FBL FELASDAD P81 Ifo
- Fort1Z FE2 FE2/EXSCLO free
@ Poril3 B3 B3 free
5@ Portil PB4 FEd free
;o S FES free
+(f AD FRR FRR Free b
(P Serial S | >
NECTSKOKF2: uPDT8F054T 80 | fprs: 8MHz|frl: 240KHz|fsub: 0KHz

4-3 Applilet [f] Pin 57
AT LA Applilet [R7INT FR28 GRS S B BRI BT A TR WA S &L, a0 N TR

EZEM-1 #5595/t 29
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Sl

pplilet2 for T8KO/Kx2

File Peripheral
e o8
Peripheral | Memory | Funetion |
Fin | IR
¥ ) IHT
e ]

#-(P Serial
=P Timer

=1 oD
£ I
£ INTTRO10
-6 ThOL
# INTTMOOL
£ INITMOIL
- TS0
- THSL
- THHO
B TIHL

#-(P WatchTimer

+-(P LT

Qptions Help

§ 7 01 B | @ F | cCT8ED Compiler -

[D:\test\EZEM

[ Trigger

NECT&KOKF2: uPDTAF054T_80 | fpre:

Hame [ 158 [ Status
INTFO INTPO input HI_INTFO ot used
) IHTPA ingut MD_IHTF1 Hot used
INTFZ IHTFZ input MD_THTFZ Fot nsed
IHTP3 IHTP3 input MD_THTP3 Fot used
INTF4 INTP4 input HI_INTP4 Hot used
INTES INTPS ingut WD_INTPS ot ussd
INTEE INTFE input MD_INTFE Hot uzed
IHTET IHTFT input MD_THTFT Fot nsed
THTER Hey interrupt WI_THTKR Wot used
INTAD A comversion end ND_INTAD ot used
INTSRO VARTO reception complete MD_INTSEO Hot used
IHTETO VARTO transmit complete MD_THTSTO HFot nsed
TNTSES VARTS reception complete WI_THTSES Wot used
INTSRES VARTE reception error MD_INTSEES Hot used
THTSTE VARTE transmit complete WI_IHTSTE Hot used
INTCSTI0 CST10 interrupt handler MD_THTCSTIi0 Fot nsed
INTCST11 CSI11 interrupt handler MD_THTCST11 Fot used
INTACST CSIAD communication end MD_INTACST Hot used
INTIICO IICO tramsfer complets WD_INTIICO ot used
IHTTMOOO Match between TMOD and CROOD (khen co MD_THTTMOOO Used
IHTTMO10 Match between TMOO and CRO10when com MD_THTTMO1O Fot used
INTTMOOL Match between THOL and CROOL (when co... MI_INTTHOOL Hot used
INTTMOLL Watch betwsen THOL and CROLL Gwhen co... MI_INITHOLL Hot used
INTTMSO TMS0 and CRSO match MD_INTTMSO Hot used
IHTTMS1 TMS1 and CRS1 match MD_THTTMST Fot nsed
THTTMHO TWHO and CMPOO match MO_THTTMHD Fot used
INTTHH! THH! and CHEO! mateh MD_INTTHH Hot used
THTHTT watch timer prezcaler WI_IHTHTI Hot used
TIHTHT wateh timer OVF MD_THTHT Fot nsed
TRTTWT When snnmlw waltare less detertinn w T THTIVT Wnt nsed
5 !
Mz |frl: 240KHz|fsub: OKHz

%

K 4-4 Applilet () Int Fif

RS R IR 55 R U AL FRREA T B T, BT ADRAR A 1) i 44 05 3

30

pplilet2 for T8KO/Kx2

File Peripheral

Qptions Help

[D:\test\EZEM

B H B E % F 0@ B @A oD Compiler -

Peripheral | Memory | Funetion |
0T

Fin

P System

£ THT

7 PORT

P A

(P Serial

(P Clockat
(P Watchdaglimer
P Timer

(P WatchTimer
& w1

& o

£ Others

el Gl B B B - G -

A ISR AR BTBEE (1 Bl BEAE AR e (KA () I 5 55 e 40 o

SPE Fame | Address

05CCTL 0xD00DEEDE
EOM 00000 £€40
MCRH 0000 21
nMoc 0000 ££a2
05TC 0xD00D €23
05TS 00000 ££24
PCC 00000 ££5 D
IF0 s0000 £Fe01
TFOL 0000 ££ell
IFOH 00000 €1
IF1 00000 ££e2
IFIL 0000 ££ 22
IFIH 0000 £fel
o] %0000 ££=4
WKL 0x0000£€e4
MEOH 0000 ££e5
ME1 0000 ££efe
MKIL 0RD00DEEeE
MELH 00000 £€e7
FEO 0000 £ e
PROL 0000 £fel
FROH 0aD00D££eS
FRI 00000 £ £+
FRIL 0x0000£fea
FR1H 0000 £feh
EGP 0000 ££485
EGH 0xD000£E49
KRN 0x0000£68e
PO 00000 ££00
L 0000 ££01
P2 %0000 ££02

NECT&KOKF2: uPDTAF054T_80 | fpre:

BNz [frl: 240KHz|fsub: OKAz

K 4-5 Applilet () IOR Fiifi

EZEM-1 $53F

AAE IR

n LUl Applilet (7IOR R4S TR IS 7 (R IR D HE W A7 S IR 00, 40T [T -

VB T B AR L BT 5 A7 4 A4 BRI E AT i T W i, 7 (] A



¥4 S A T Applilet

4.3 HHRAH

1 UPD78F0547 [t Jr N6 T 8 /MR, 43l & System, INT, PORT, Serial, AD, Timer,

WatchdogTimer, LVI,

# 41 uUPD78F0547 4+ 4

S LA PN

System RGHARE

Port A0 A\ 2 v
INT Al BT 9% 1) 1R
AD AD HA a1 i
Serial FR L E TR B
Timer JE I /T B 1) v
Watchdog Timer BV I 28R
Watch Timer B E I 25 1) B
Clock Output BBl ()

LVI AR Ao P00 B

B A B Y B Ty e R ¥R U 2 W (T8KO/KF2 8 A B Gl 4% il 2% H o T 0D

(U17397CA5V0UD) .
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B5HE LRI KI5

AREAGFUATAEH PM+ T H,

51 {FHAPM+ 4Ri¥

511 JAziPM+

R IR >FE > NEC Tools>PM+ V6.30" &b, K2 sf it N AU o WAL 26— IR AT
PM+2: B 2l iz sl — X A H1 1) Workspace

5 PM plus - No Workspace [ProjectWindow] i o (] ]
Elle Edit Find Laver Wiew Project Build Tool window Help
|2 DS H|EE| & 0= d+»+-[Bml2
I = e

= ProjectWindow E -0l x| = -0l x|

Files |ME,,.U | - [EOF] zl

[ F——
=
[l H oz

For Help, press F1 I L [ 2

K 5-1 J33) PM+
512 TFERE

Project:

Project &4 PM+i5 3L —ANIT, $578 PM+IRES FIFRII— AN RS, PM+¥55—
H RS BN SCIE . AR AR B ) T H e 10 DA K G 48 2% a2 4545 B IR 31— NI H
SCPE Coprp) B G iR R AL AT H BT AT, DA, B R i R 0 H AR 1
MATHH (active project) 7, nJ LU % £8" Project”>Z .+ )" Select Active Project...” 32 HLIIHEF T
WH.

Workspace:
Workspace & —/MEELZ AT H (project) SCAFRIHLIG, PM+HEIX LI H ST SCAE 4 R AT
F|—A> workspace X1 (*.prw) i,

Project Group:

ZASCE M H AT ORIV SE 30 H 24— AN, X4t JE Project Group. 13— H
2 FP DA ZBUARE FE A [ 1R 8 6 SC A

32 EZEM-1 8 F



oS =

% 5 H

ST RIS

IDL file:
IDL file /2 —AMEAFE PM+ EIRK RT3

Workspace
f:?',' PM plus - Sample.prw [QutPut] M= B3 I

Fil=  Edit Find Layer “iews Project Build Tool Window Help

[2-DEW SR 4 =2 G ER B
‘ Imain-Servo Control _leebug Build LH Lo £ A | i |
T i Foww_ mE)|

Fles | Mema |

I Button Control : 3 Project(s] =eiff——_q

- [ECF] ﬂ

i T~ ———=="Project grouy|
=% Servo Control - 2 Project(s) -l ! 9 P

@ main “\__

E-_JD Source Files - R

ECI Include Files >Prolect
[#-[Z Project Felated Files

(0 Other Files‘/

-3 Semvolibra

L

KN Ay

For Help, press F1

T LTRIFT 4

5.1.3 #FEWorkspace

IE e

Qpern. ..
Inserh File. ..
Close

Kl 5-2 PM+#AES

ChrlH-M

Window  Help
ChElHC

Open Workspace. ..
Save Workspace
Close Workspace

FAE ] PM+8 F IR H, 2 A7 5 g L — 4 Workspace . ik #% "File” 32 B 1 1] "New

Workspace...”, 4] 8 g 1G4 .

5-3 #iidt Workspace

New WorkSpace — Step 1/9 [Workspace Inform... g‘

# Workspace File Hame

|EZEM

# Folder :

331, Workspacs
2. Select Tools

[" Create Blak Workspace _ 3. Select Real-Tins

[D: % test\EZEM
Froject Group Name :

Browse. ..

# Microcontrollers Hame

g e o T. Setup Source

|TaKD

8. Sslect Deb
~| [wrreroser e v | St

Device Install

9. Confirmation

#) vEs0
Only (4-6)

Thiz will =et up the basic information about the workspace and the project.

| T—i ) > | B FEEh

EZEM-1 $53F
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K 5-4 New WorkSpace — Step 1/9 X} ifiHE
Step1/9 X FHEF B AT N2
Workspace File Name#7 i #] Workspace £ K. XA Wk SosEbRigies |-,

Folder BT TR SO RIAF TR H 55 o

Project Group Name il A ¥ Project Group 45

Series Name Project {{i FH I ¥ % RANAFR. N hrsg it O3 5 e &40
Device Name Project XJ M. I & K. T HSR R O e 36 1 T i 45 S 0K

W RE, sl 24, HIL T RGP HE SteP2/9, ] LALE 2 Fidh P AR 2%
H ik $e. JoH S EZIEM-1 & 24T I A48 2 ID78K0-QB-EZ. 5 BF-ahikFA4 Refi H .
New WorkSpace — Step 2/9 [Select Toolsl E|

Tool Set

1. Workspace
]fSelectele)TSKD Software Facltaze V4. 00 (Engzlish ‘.l'erLJ | 332 Selact Tools

Tool Versions

Tool | ¥ersion
CCTSED 4. 00 Link Tl
RATSED 4. 00 :
SKTGED ¥3.00 .. T. Setup Source
ID7EED-QE ¥3.00 8. Select Debugger
IDTSE0-GE-EZ lnuzed ; ;
SN+ for TEED Ve 20 9. Confirmation
BSTEED V2. 00 ) vaso

Only (4-B)

[V Select only Installed Tools

Flease select the Tools from HEC Electronics to be used

The following tools hawe been excluded from selection because they are not
installed

<t—f@|T-sw>| By | ®=m |

5-5 New WorkSpace — Step 2/9 %JiFHE
H: Step3/9~step6/9 L1120 V850 RANMGHILHEIITIAE, AN IEPHRIE RS, EEIHBIOIE, T
2o FEPAREE RNEE (A7 b B SO

New WorkSpace — Step 7/9 [Setup Source Filesl [g|

Fleaze setup Sowrce Files.
1. Workspace

2. Select Tools

Source File Name

>PT. Setup Source Files

G Select Debuzzer

9. Confirmation

Q (#) V850

Only (4-6)

You can alsoe add =source files by specifying the list file or the folder.
Tou don’ t need to specify all the files here, and wou can setup source files nsing
[Froject]->[Froject Settings] later.

(tF@|T-fw o] i L
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5-6 New WorkSpace — Step 7/9 XifHE
11 Step 7/9 TR INYESCAE . fitT A RS IS SCPE, FTLLE C i 5 WS sy g YA
A
RO TEAE" T — "4, LB X I HE Step8/9.

New WorkSpace — Step 8/9 [Select Debusszerl [g|

Please select the Debugger.
1. Workspace

2. Select Tools

# Debugger

File name :

|C : \NECT001s32 \TEKDAIDTEK0-RE-EZWW3. 004 bin' i dkD32 gmon

T. Setup Source
Option : >28. Select Debugger

9. Confirmation

#) vaso
Only (4-6)

You can change the selected Debugger using [Teol] - [Select Debugger].

(t—Fmw[Ff-sw>] @ms | we |
5-7 New WorkSpace — Step 8/9 XJifHE
RHFAE Step7/8 ik BN, T RS RARM T DA AN BT I 21
R HEAE" R — 7, LA IR HE Step9/9.

New WorkSpace — Step 9/9 [Confirmationl] [Z|

Create the workspace and the project
1. Workspace
Horkspace File Hame I B e T n i

EZEM. prw =
Folder :

D:hkestWEZEMIY
Froject Group Hame :

Microcontrollers Hame

Device Hame :
uPDTEF0S47_50 |
Tool Set Fame : g. Select Debugger
(Changzed) (Selecteddl)TEED Software FPackage ¥
Tool Wersions :

T. Setup Source

»>23. Confirmation

CCTEED ¥4.00 #] Vas0
RATEED ¥4.00 : JDnls«' [4-6)
SKTEED ¥3.00

IDTEEO-RE V3. 00
INT8KO0-HE-EZ ¥3.00
SM+ for TEED ¥2.20
ESTSED ¥z.00
Debugger :
IDTSKO-HE-EZ ¥3.00 TSED Integrated Debugzger B

3 | =

mE | mm

5-8 New WorkSpace — Step 9/9 %[ iFHE
XS TEHE Step9/9 i G ¢ i A5 FTHAE o
AdPse R, —ANM4THiY WorkSpace i 4f T .

EZEM-1 5 SF /M 35
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5.1.4 ¥[FFWorkspace

File bz il Window  Help
= Qpen... ChH+0

Inserk file. .,

Close

Mew Warkspace. ., .

Open Workspace, ..
Save Workspace k
Close Warkspace

5-9 #TJF Workspace
RN O TR, R File”s 5 b ["Open Workspace”, 11 JF Open Workspace X} 5z :

Open Workspace

BHIEE 1) | EZEWL00RME v @ cF B

[Clezzn. oxv

IS () 1EEEH. prw I3 @) |
JCHRZER (T J'l'l'orksp ace File 0k prw) :j il I
#hw |

5-10 Open Workspace X} & fE
1%+ Workspace S (*.prw), s T R4, atnl LLEZHUH Y. () Workspace

36 EZEM-1 8 F



5.1.5 BuildLf&
R E AR, Build — TAEE =42 —#ERACHS SCE (Klmf), s FE SO (*lib).

Build T2 K% il Build #2411 &, 8l M3 ¥ 6% Build->Build”

i PH+ EZEM. prw [D:\tes

Eale Edit Find Layer Yisw FEroject B Iool ¥indow Help
a-DEE &R @ §  busld gad Debug F5 R°E ?
Bebyild snd Debug
[Apptitat - Thk Series = |[Bebug Buils  Conpile CreloFT
i ProjectWindow |- [OX| D ant \EZEM100
Fila |bee | Bebuild "+ Nomet =
= 05 Tok Series : 1 Fraject(s) Bagech Build 1
~ @ amsiiiat Batch Rebuild i
s ::?::...4’11\ Update dependencies __ineerrupe void MD_INTTHOOO( ) 4
% ) Praject Eeluted Files Clem i /v TODO wh
Dot Files Edit P2.0=!F2.0z4
Rebug P2.1='P2. 124
" 1
'
Select Duild Nods. .. [EQF)
Build Settings...
Batch Build Settings...
i - =
q » 4 LI
U
- [ECF)

Start build CRLF L: 1 X: 1 ¥: B8

% 5-11 Build T.f%
WG PEEREA IR, 44 LY EHE"Build Completed normally”. 33X s il LLEEAT
— SR T .
5.2 HEI&E
PM+4 F P 4248 T 38 I s s B D RE
521 ZHiFER
1% H Tool” >k . [¥)"Compiler Options...”, HJ LLFTJF Compiler Options X iFHE, FEHL T 441k

PuAb oA 345 1) PG T 01
Compiler Options rz|

Output l Extend i Others I Startup Routine i
Preprocessor i Memory Model i Data hA=zsign i Optimize I Debug

Define Macra[-d]

B3 Edit...l

Undefine Macro[-u]

| = Egit...'

Include Search

- Edi;...l

Command Line Options

e B | mEw | =m |

¥ 5-12  Build T

EZEM-1 $53F 37
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5.2.2 JC4RIEIR
1E P Tool” X b ff)"Assembler Options...”, $JFF Assembler Options Xf 1if#E, &4t T gn ik
= PEC B
Aszssembler Options E|

Outputl ]UutputZ ] Others 1

~Object Module File[-o]
Output Path Hame

]l LJ Browse. ..

-Output Debugzing Information to Object File-
¥ Loeal Symbol Data[-g]

|v Aszembler Source Debugzing Data[-gza]

~1 Create Error List Fo
] =] e |

[~ TEEODS Common Object Madule File[-common

Command Line Options:

W e | mEw | #m

K| 5-13 Assembler Options %JiFHE

523 BEEEM
e Tool” 3 B i [f)Linker Options...”, #T7F Linker Options XJiHHE, it T B a i)
HRB RSO R R SO S E

Linker Options

Outputl ]UutputZ ] Library] Others ]

Load Madule File[-a]
Output File Hame:

i j Erowse. ..

v Output Symbol Information[-g]

I Create Error List File-

Command Line Options:

[~oEZEM. Inf ~bclOsx. 1ib ~helOs. 1ib ~belOsE. 1ib ~iC:HECTools32
WTEEDSACCTEEDSYE, 0041ibTEk0s ~dk dr -5

W B | mEw | s

5-14  Linker Options X} i%#E

38 EZEM-1 $53FM



805 W ARNITRIEE

AN IR S B AR s, DLURRCE AR ST RIE R, MFEF A A m
FOMA, XA ) R A YA A B (PM plus Ver6.30 User’s Manual) (U18416EJ1V0), XA SCAFAE
2R PM+ERAE I o2 A sl g, 791 75 X4 JF 46 > #2 5 SNEC  tools32->78K0  tool
documents>PM plus>UM V6.30 PM plus”, V6.30 &RAS, wJReasf Al
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6 T A {fiH EZ/EM-1

F6E WMAAEHEZEM-1

KEANF EZIEM-1 A 1 2G5S N AR IR i 3 T,
6.1 EZ/EM-1 NE

6.1.1 FERAER

1. AT NEC 4 %% MCU ik, (HJE HARBE &1 E OCD (RLer=igi 5 a4 4
xxxxD)

B X, X2 51T, ] DU ik At OE A

ALK R N8RS K Flash 7 #s h A LIE 17

TF AN YR (USB 241t 5V it AL AL KD

AT LA B H AR R G0 T SR A 3 s

ANE/ANTG (25 * 30mm, EZ) 20 )

FHeZ¥ USB1.1 Al USB2.0 £: 11

6.1.2 HAIEEMAE

No g s b

Full Package

EZ/EM-1

All Flash

EZ Emulator
for
T8KO0S/78K0/
T78KOR/V850

Portable Bag

Pins for
External X'tal

Cables to Target
Board (2 pcs)

Installation CD

Roll-up USB Cable |

El6-1 EZ/EM-1 30044 &

AP aLEE 6 TN 2
<1> EZ/EM-1 £k (fAF12.5*3.0 cm)
<2> A[figi USB 4% LG CKJE: 1 m)
<3> HistERLk (8 HD

40 EZEM-1 55T



6 T W {fiH EZ/EM-1

<4> HMERGARIERT N (34D
<5> HIHE (15K
<6> fHfEL% 149
<7> {iEK (A, &R
<8> LMtk A, &R

A ERANZ Wi e A H AT EZ/IEM-1 1) OCD #:3f, B 3E4T OCD #:3, 2[5
“Fts A OCD Checker”.

6.1.3 EZ/EM-1 LR

Eg.&mulatqr

?axo I78IK0F } z
7~BKQRN850—Em-e|oek 4l s

é v m--‘-ﬂ' e

3
&
-

ON
Int. VDD -4- Target VDD
Stand Alone -3- Debug Mode
Ext. Clock -2- Int. Clock
Tx/Rx OR-Tie -1- Open

Made in China

& 6-3 EZ/EM-1
6.1.4 FIHFMCURE: O %

EZ/EM-1 F1H b5 MCU Z IRty SR 2R, HARMI SRS FIIEE0E S 2% QB-MINI2
RFRTIRE N BT AR AT (U18371CAIVO) o BLAMY A HE & 7= b R A k)i T 4,
To 8 U T LSRR A g B2 T e

EZEM-1 {8 F 41



%6 T Wi H EZ/EM-1

1.

e

42

EZ/EM-1 &5 78KO0S I #1474

fit e BB s
GND +V
GND _— VDD
VDD 3 :E1K 3
3K - 10K !
CLK L i X1P121
RESET-OUT RESET/P34
XD X2/P122
RXD
uPD78F9222
FLMDO
RESET-IN

K 6-4 78KOS [)ZmATE R R

oo | A

+v
I _
GND Vss vDD J
VoD 2oz %sﬁm
CLK s X1/P121
RESET-OUT RESET/P34
TXD X2/P122
RXD INTP3
1KD :: 2 'Kn
FLMDO T % uPD78F9222
RESET-IN [+
| SRS S

Kl 6-5 P e S A HI I PRI s

1. RESET 5| BB HIAF 7R 2% 2l sl AT i lresetinh N MR 7 . BRIL, %51 I W RESET 5N &
T REATERALH -

2. JXIEAE H AR RS H AR X RIX2I 105 | I

3. WL R AE, AL Bl

4. JERAZS | AT 4 s AN runAlbreak Z (A (IR RTINS B2 . B 5 1 IO, Rt 2 nTAT HG, H A
2B LA B K R

5. INTP 5| I 75 A0 IMINICUBE 2 H bR B4 ] 38 1R KU, 44 HIMINICUBE23 AT AN, INTP
FUMAIE I D e A RERAE I .

EZEM-1 $53F



%6 T Wi H EZ/IEM-1

2.

bt

EZ/EM-1 42 78KO I [11422 7 45)

1t E ER
GND A 42 +V
|
GND I 94— VGG VDD
s e T ‘%minm K EVSS AVREF
10K Q10K 1ldn]
CLK 1 P122/X2/EXCLK/OCDOB
RESET-OUT RESET
TXD + TxD6/P13
RXD RxD6/P14
FLMDO & FLMDO
RESET-IN uPD78F0547
K 6-6 78KO/Kx2 [14mFLiE R~
ecno THEHER +V
é
L !
GND b3 3 vsS VDD
vop H [ ki AVSS EVDD
EVSS AVREF
CLK P121/X1/O0CDOA
RESET-OUT RESET
™ 1% P122/X2/EXCLK/OCDOB
RXD | Toxo Fxo uPD78F0547
FLMDO FLMDO
RESET-IN P31/INTP2/OCD1A __§me
| b e

K 6-7 78KO/Kx2 [ I%E R~

1. K HARBRAIITXD CRIETD EHEIHAREROMRXD GEICT), R HAREREDOTXD CRIETHD
HRE HAR B MRXD (i)

2. PRI R, TR 22/ 78K0-OCD R[4l e an R et g, T LUE FHHMINICUBE2 (1)
4M, 8M H(16MHz [Hith. (gl firk, Kl LMER4M, 8M a16MHz [#i4l.

3. W, EREIPT 1-2 i, FIEREIP2 (91-2 . gmFRRT, dERHEIP 5E2 RIIP2 [HEE2 .
7 H AR AR (BATIEBMINICUBER), IR ERIP1 FIJP2 JTi .

4. FMARE B LIOCDIA AT REAR, thinP31. HARME LB H A5 &0 H 7 Tt

5. XFmERMBEUCHIRESET (55 & MN Wi TFRgma ChthBapt: 100 BRAFEEE /N .
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6 T Wi fi ] EZ/EM-1

6. FEREAMEN I RLER R I Flash Agnfe Bt , Billn i HEHIFLMDO. {1 im HRE AR o A
] BT RENS, FLMDO A 4 AL BELEE B AT BLiZ1-10 kQ.

3. EZ/EM-1 ¥%E4% 78KOR IS 14 11 745

e F
o | el
d
GND E VSS E:gg
< : AVSS
VDD — 2 5% EVSS AVREF |1
CLK
RESET-OUT RESET
XD P40/TOOLO
RXD uPD78F1142
FLMDO FLMDO
RESET-IN FEFRPYSBR o,
Kl 6-8 78KOR [t)gife i 4ol
GND 1:;H\:EE.EE‘;E +V
l
GND 9 VSS vDbD
) t AVSS ENDD
CLK ho
RESET-OUT RESET
D P40/TOOLO X1 —H
2 2 =
RO | 3,3, uPD78F1142 o T4
FLMDO FLMDO
RESET-IN [«
| SR

¥ 6-9 78KOR [1 2k I B
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%6 T Wi H EZ/IEM-1

LR R ;
GND f &8 £
)|
GND vss VDD
3 32 t AVSS EVDD
v = it [t ¢ EVSS AVREF —
CLK P41/TOOL1
RESET-QUT SEeET
XD P40/TOOLO X1 —_ﬁ
2 3 =
RXD Yioka Yo uPD78F1142 ‘o II
FLMDO EiSh
RESET-IN [+
|—-{ S1-2B 5L 7 LR

K 6-10 78KOR XL I B

b 1. X TMINICUBE2R iz 21845 (1 2k % A i 23% LA YRXDANTXD A N LR 1) o U 2RAL ] HiAt [ Flash
FRARIX LT | L2004 L H AR R GE O ARG R 4% N 8 7T REVCAT BT
2. ZATIAHERZ BB T oL AU, EAE PR T A2, (HAERAAEUT IMINICUBE2 B A 4%
(I 2, B EAPEAR AT O I A5 I b b4 s S Bl
3. X e B ikresetfs o MNVETEFFIRZE A% CRvH BELBT:  100RKISETE /) iy H 1,
4. S RS Flash& 225180 F I REZRAE Py 1) B B AN T EE 1

4. EZ/IEM-1 #E$#: VB50ES I (142 L7 1

'H 3
o | HmmE
L
1k-10K0
GND vss TLMD1 ngg
AVSS
VoD b3 BVSS EVDD
CLK Yoo L— EVSS AVREF(
AVREF1
RESET-OUT RESET REGC
XD P31/RXDO/INTP7/TO03
RXD P30/TXD0/TO02
FLMDO ——% FLMDD uPD70F3732
RESETIN |«Zof 0 L fo

sl
4 6-11 V850 f1U3EHe 5
B 1R ERRRAIOTXD BT HERESIHBRER CORXD (B, M FARER N IITXD (K% i
B FARVEATORXD. (Rl ). WIS HEFlash SR 10 FERS PRI 847 L3I A4 FR
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6.1.5

46

2. %5 | H{cFlash Zwfsmt ]

W

o g b~ W

ok
fts

BTN RERT, FLMDO AME ) Sz s KR AT AR 1-10 kQ-.

[RIAH K e & B 7 1

—_

EZ/EM-1 %4 78KO0S I 11322 L7l

H#R#t%: uPD78F92xx

B ORARBEAM IR B4, 8 516 MHz). M4 )7751ES % Hiras i - T

TR R T B A PR AS (HI-Z), PR R DU 5 | B S5 Th R

XA EE KB SN RESET 55 AN VB TT IR Zevh s Gt FLBT: - 100Qu 58 /1 it )
. fEAHEATFlash GiAEfidFiy, ANl ZEevh i ZoHE N i R e
- HELHEN ) B2 A Flash A gL B ih i, Bl i P2 HIFLMDO. A3 i R A Jan i) o i~ o AN

AT 4RENEHIER: WriteEZ2

REERHI

1) “3H -> BFRRAIR” WriteEZ2Ms T AUBIE R (12.3.5
FERE SEEWriteEZ289124F)

QREMFLIE (1)USB E#:, () BaBHEfF, BE, ()
EER%. BRRER EROJUENE “WriteEZ2” FHF R

Ei=pat
GND B#riR
VDD | VDDEEL WL AEERIB iR
I e ﬂi?‘JVDD:f‘b{»}VDDB@ﬁﬁJﬁ
RESET-OUT RIS A5 el
XD ME BAFR A EREH
RXD %, AEMAEZ/EM-1H
FLMDO VDD . XFHEMR T, VDD
DA RSB AL L L
RESET-IN

REGC 5IHpAEEZE VDD,

2. i EZIEM-1 5\ 78K0S I [r13%E 7~

Tx/Rx OR Tie Open

Made In China

T8KO0S/T8KO/
TEROR/VESD

| s
% GND 1/\EEEE.IE Y
GND _L_ VDD —1
J Vss
VDD
— CLK X1/P121
s, | = RESET-OUT RESET/P34
at TXD X2/P122
o]l RXD
=10l uPD78F9222
4118 ]]] FLMDO
7
RESET-IN

EZEM-1 $53F




St

6 T W {fiH EZ/EM-1

3. il EZZIEM-1 ik 78K0S i (S~ ] CIRFERERF S N0

Tx/Rx OR Tie Open

use

EZ/EM-1
Al Flash

Target

On-Chip Debugger |

T ==
78KOS/TBKOI = 2

78KOR/VES0 L T ®
Ext Clock

Eﬁﬁﬂﬁa’%)\ﬁ] Biriek, WHEAUT

:H: 3
oND e B iE W
GND :i_y Vss VDD —T
VDD
CLK X1/P121
RESET-OUT RESET/P34
TXD X2/P122
RXD INTP3
FLMDO uPD78F9222
RESET-IN

1| Ext. Reset Circuit |

4. M) EZ/IEM-1 3K 78K0S I IFER R ] GRIZEFRF BN L)

MEBRFPHSAI BRREZE, B
PUFER. R B B AXLRX25 .

-----

Stand Alene -3- Debug Mode
Ext. Clock 2 Int. Clack
TxfRx OR-Tie -1- Open

Made In China

Tx/Rx OR Tie Open

UsE

:H: N
oD it e B B W
GND j—w Vs VDD J
— VDD
CLK
RESET-OUT RESET/P34
TXD
RXD INTP3
FLMDO uPD78F9222
RESET-IN

EZEM-1 $53F
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f 6 W {fiH EZ/EM-1

5. 1] EZIEM-1 ZHz 78KO0 W 4% 1 741

Biris:

GND
VDD
CLK
RESET-OUT
TXD
RXD
FLMDO

RESET-IN

78K0/Kx2 %51l (uUPD78F05xx)
78K0/Lx2 %%l (uPD78F036x/037x/038x039x)
78K0/Lx3 F3Fl (UPD78F04xx)

A FRENEHIEF: WriteEZ3

HAntR

SRS b

VDDEEL A AEEE] B iR
#HAYVDD, X i VDDRIIR 3 TT

VDD . XFIERT,
DAJR R MR e L

ISR H pn e e BB At o
B, NEEHEZ/EM-1/)

VDD

REGC 3IBlisJ%#ZE VDD,

6. 1l EZIEM-1 5 A 78K0 Itf ({14 4% 7

Tx/Rx OR Tie Open

H §
o | EEmEE
GND E VSS VDD
AVSS EVDD
4 VDD —
. EVSS AVREF
NEC £3& r CLK P122/X2/EXCLK/OCDOB
RESET-OUT RESET
EZEM-1 [
E All Flash a TXD TxD6/P13
On-Chip Debugger 1
for ir=c RXD RxD6/P14
7BKOSTBKOl = -2
Wit ol FLMDO FLMDO
RESET-IN uPD78F0547
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7.

% FHEZ/EM-11835%7 8KO I 11 32 32 7= 441l

Tx/Rx OR Tie Open

ono  HEEE

+V

GND

VDD

CLK
RESET-OUT
TXD

RXD

FLMDO

VSS
AVSS
EVSS

RESET

RESET-IN

FLMDO

VDD
EVDD
AVREF

P121/X1/OCDOA

P122/X2/EXCLK/OCDOB
uPD78F0547

P31/INTP2/OCD1A
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fi 6 7 Wi i F EZ/EM-1

8. fiif EZ/EM-1 ﬁz%ﬁmR N ARPR ]

AR &
78KOR/Kx3 %%l (UPD78F11xx)
AT HBNEHIET WriteEZ4

GND H #riR
'— VDD VDD#EEL A AEEE] B iv
— ok e #RE9VDD, T VDDRIIR B IT
KiE PRI S o0
RESET-OUT
| TXD R B br B AR R oA
RXD B, AEMEFHEZ/EM-1H)
FLMDO VDD . iXFHEHL T, VDD
DAI R S B B YR
RESET-IN
REGC 3|l J%EEE VDD,

9. ¥l EZ/EM-1 5\ 78KOR I [¥)i% 27 151

Tx/Rx OR Tie Open

H jt p s
on oFF l GND 1'\ EE' EE'IE +5V
Int. VDD 4- Target \J'DD= |
—_— J GND VSS VDD
. VDD AVSS EVDD
EVSS AVREF
CLK
RESET-OUT RESET
TXD P40/TOOLO
RXD uPD78F1142
FLMDO FLMDO
RESET-IN 5 FR BB R 4.
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10. f#i /] EZ/EM-1 {18 78KOR I ({13~ (gt

Tx/Rx OR Tie Open

ON OFF GND 1# m EE;J?: +V
Int. VDD 4- Target VDD
e Choh gl ot taodte
TulRx OR-Tie -1- Open
Mede in China GND VSS VDD
\ / EVDD
AVSS
vob |
E Sves AVREF
CLK
RESET-OUT RESET
XD P40/TOOLO X1 |
RXD uPD78F1142 _'||::||
X2
FLMDO FLMDO

RESET-IN
—I—{ SR |

11. 1§11 EZ/EM-1 3K 78KOR B (RG] (A=)

Tx/Rx OR Tie Open

oG fad 3
OoN " OFF GND 1'\ m ml[ﬁ +V
Int. VDD -4- Target VDD
Stand Alons -3- Dobug Mode
Ext Clock -2- Int. Clock
TulRx OR-Tie -1- Dpen
Masde in Chima GND E VSS VDD 3
\. EVDD
AVSS
vob
By AVREF
P
nEc E3E =l CLK P41/TOOL1
RESET-OUT RESET
2 XD P40/TOOLO x1 =1
RXD uPD78F1142 _'||::||
k FLMDO FLMDO X2

RESET-IN
—|—1 shaspeg |
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12. f# ] EZIEM-1 i&E % V850 I 142 7~ 5]

B

AT mRHEHIRER: FPL

VB50ES/KX1/KxX1+/Kx2/FE2/FG2/FJ2/HE2
V850ES/HG2/HI2/3G2/32/SG2/SI2/IKL/IE2
VB50E/IA3/IA4/IMA3/SV2, V850/SG2, uPD703229Y
(AT MEER VP35I HE 3%, )

13. f§i ] EZ/EM-1

HATiR
VDD LW IUE R B An
GND #REVDD,E & VDDMIIR N
VDD SR PRI 0 AT
CLK X R B AR B A
RESET-OUT %, ANEMFREZIEM-1
D VDD ., XFEM T, VDD
DAIR RSP R L YR . AR
RXD 4 VDD25 |, VDDA VDD2
FLMDO AR DAIT M ER R AL
RESET-IN
%"ﬂ% I EL M B R R G B

REGC SIRlisJE#EZE VDD,

BN V850 I R

Tx/Rx OR Tie Open |
J

J5B

EZ/EM-1
AN Flask

for

TAKOR/VE50

==

L
=

On-Chip Debug s

_— N
GND e R +V
1
1K to 10K
GND vss TEMDL - ypp
BVDD
|| AVSS

! vop BVSS 2unk
CLK EVSS e
_ AVREF1
RESET-OUT RESET REGC
XD P31/RXDO/INTP7/TO03

RXD | P30/TXDO/TO02
= FLMDO FLMDO UPD70F3732
X1 X2
RESET-IN J_—||:| |—_l_

L%

S A B |
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6 & Wi EZ/EM-1

6.1.6 EZ/EM-1 4 HIE X &5 10/16 D% #
# 6-2 EZIEM-1 EEERLHEE

S | 2% Bifs | SN far A
1 GND TN Hbr 240 A5\
2 VDD £ iyt Hbr 54t CPU & A7 it
3 CLK AN fan
4 RESET_OUT A H br g8 s e 2R
S TxD PNE N-CH # 4% (&%} TXD Fil RXD)
6 RxD —
7 FLMDO i3 v th It as
8 RESET_IN K —

EE: BARHBKTT RN EZEM-1 TS

e 2 P H bR CEE O T B4 B MINICUBE 19 10 4F i 0, Al e i i
MINICUBE2 ] 16 £ ifilkgmfe & e 0. bR T H A nr & i i 78K0 {5 BB 8 &4 11 A1
16 %0 . ZRRAK) 78KO0 17 ELAR A 10 &2 0 F1 16 41420 .

10 B H BRI 5 LU T

#* 6-3 MINICUBE 10 48884 i &
5 %S 5|2
RESET IN
RESET OUT
FLMDO
VDD
DATA
GND
CLK
GND
R.F.U

Slo|eo|N|o|als|win|—

£ MINICUBE2 W55 &
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16§ H bR R LT -
#* 6-4 MINICUBE2 ] 16 4 & Ea4T R &
EllErhes FIE R
AT | T
1 GND
2 RESET_OUT
3 R.F.U. | RXD
4 VDD
5 R.F.U. | TXD
6 R.F.U.
7 R.F.U.
8 R.F.U.
9 CLK
10 R.F.U.
11 R.F.U.
12 R.F.U. FLMD1
13 DATA R.F.U.
14 FLMDO
15 RESET_IN | R.F.U.
16 R.F.U.

7 MINICUBE2 WIS 'S &K

¥ B4 st LBt T NEC 10/16 £1H45  fso,  af DU AT 45 6, Bt
B, AT RGO SRR, EZIEM-1 (I CEEIHES% 6.1.5 T,

78KO0S ) 16 41, BEn I TF4mfe, trlH Tk, 5 EZIEM-1 R T £,
EZ/EM-1 FHT i, 5 78K0S 1) 16 4148 4.

EZ/EM-1(i) 16-pin e/ HE: 0
51 g 51 D

1 GND 1 GND

2 VDD 4 VDD

3 CLK 9/14 CLK

4 RESET-OUT 2 RESET-OUT
5 TxD 3/5 DATA

6 RxD 12 INTP

7 FLMDO NA

8 RESET-IN NA
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EZ/EM-1 [ T-94F2, 5 78K0S [ 16 41482 1546

EZ/EM-1(4wF2) 16-pin e/l 1
5| B e 711 e

1 GND 1 GND

2 VDD 4 VDD

3 CLK 9/14 CLK

4 RESET-OUT 2 RESET-OUT
5 TxD 3/5 DATA

6 RxD NA

7 FLMDO NA

8 RESET-IN NA

NEC & 78KO0 Z 41 5. i HLER AL T W Fh4% 11——10-pin F1 16-pin, A4 10-pin #2110 R AL T

Wk, 16-pin 42 1B w7 FH TR v B Fn e
EZ/EM-1 ] Tt 5 78K0 10-pin #2101 CHt) M.

EZ/EM-1 G 10-pin ik
51 e S e
1 GND 6 GND
2 vDD 4 VDD
3 CLK 7 CLK
4 RESET-OUT 2 RESET-OUT
5 TxD 5 DATA
6 RxD NA
7 FLMDO 3 FLMDO
8 RESET-IN NA

EZ/EM-1 I Tt 78K0 16-pin #3210 (4 F/iHt) .

EZ/EM-1 G0 16-pin i Fe /iR 1
5| J e 711 e
1 GND 1 GND
2 VDD 4 VDD
3 CLK 9 CLK
4 RESET-OUT 2 RESET-OUT
5 TxD 13 DATA
6 RxD NA
7 FLMDO 14 FLMDO
8 RESET-IN NA

EZEM-1 #§ 3T
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EZ/EM-1 Tl T-4aF2 5 78K0 16-pin #:11 (ZwA/ i) Ry 5.

EZ/EM-1 (Zwfs) 16-pin i Fi /iR 1
5| J e 71 1 e
1 GND 1 GND
2 VDD 4 VDD
3 CLK 9 CLK
4 RESET-OUT 2 RESET-OUT
5 TxD 5 TxD
6 RxD 3 RxD
7 FLMDO 14 FLMDO
8 RESET-IN NA

FHT- 78KOR [ 16 15 JHIEE o] LAt v DLgm AR, e iRt 20 A B2/ XUk Wby 1.
EZ/EM-1 T ik 78K0OR 16-pin 1 (ZRf2/ifil) Mk, Rk,

EZ/EM-1 i) 16-pin e/t 0
51 g 51 D
1 GND 1 GND
2 VDD 4 VDD
3 CLK NA
4 RESET-OUT 2 RESET-OUT
5 TxD 3 RxD
6 RxD NA
7 FLMDO 14 FLMDO
8 RESET-IN NA
KRR :
EZ/IEM-1 Giffi) 16-pin e/ ik H: 1
5| e ElL] Bl
1 GND 1 GND
2 VDD 4 VDD
3 CLK 16 CLK_IN
4 RESET-OUT 2 RESET-OUT
5 TxD 3 RxD
6 RxD NA
7 FLMDO 14 FLMDO
8 RESET-IN NA
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EZ/EM-1 Tl T-4wf2 5 78KOR 16-pin #11 (Zw /i) rR5E k.

EZ/EM-1 (Zwfs) 16-pin i Fi /iR 1
5| B e 711 e
1 GND 1 GND
2 VDD 4 VDD
3 CLK NA
4 RESET-OUT 2 RESET-OUT
5 TxD 3 RxD
6 RxD NA
7 FLMDO 14 FLMDO
8 RESET-IN NA

6.1.7  [AAAR B KSR

Bl (R VEBAT AN DS W 4 Z BT, B AE EHL L O IE# %255 T IDxxx-QB & IDxxx-QB-EZ
PR A, EZIEM-1 1) USB KB FIAH G )B4 SO WA e R0 I IR AR A B 8y B ST At
TES 1 RT3 B ORI EZ/EM-1 [R) HARAH O B 4% (I Rk 7
1. USBE:HSINER: (EZ/EM-131)

HUSBIERZHL 48 (IMINI-Bsi (CAEFRUEMINIUSB ) $2 AEZ/EM-1(HUSB&E % 2% .

2. USBH:MOHZiIER: (PC %i).
FUSBIEFLZ M AL APCHLIFTUSBYG [H o

3.  EZ/EM-15 Hirt & ik 1§ 2 16.1.7 1.
MEZ/IEM-15 1 97 54 FT#E"On™RZA&, RIERE WAL e, H bR AR BT 75 1 FE U5 Fh
EZ/EM-14¢fit. MEZ/EM-1T5HIMIT R4 FT7E" OFFRAS, &+ Hbs R, Ik H
BRI 75 (4 FELYE 20 F A0 F R AL
KHEZ/EM-1_E3AT TR 24T, Frbllt USB L S8 8 EHLE , EZEM-1 LT 1R
INAT AN S s

4. J33)IDxxx-QB-EZ
FEHE NGRS 2 /T, AR EZIEM-1 [ JTF ISR T IE# R &

6.1.8  [FIAHIR & BT I T

DL AR T W FFEZ/EM-1 [R]FH G A& B (K e

1.  XHIDxxx-QB-EZ.

2. KRMHARRG I Caf e i R gti).
3. BEEZEM-1RIPCHLIAIUSBE: HHLZE,

4. BEEZIEM-1[R HAx RGE M &R,

PA_E A7 (R T I o SRR XN AR DU RT 2o B 3 13 s 5

EZEM-1 5 SF /M 7



6 T A {fiH EZ/EM-1

6.1.9

EZ/EM-1 KRk E

% 6-1 EZ/IEM-1 &R E

FFxR DA fEH
1 ON Tx/IRx J& 5%
2 OFF A5 FH A 10 A 8 N e
3 OFF 78KO (1)
4 ON Y A ) H PR B SR

WEEZIEM-1WIERIER G, FRBEZIEM-11S 5 TR RT3 S GRRBI,
SR 5 51Dxxx-QB-EZ .. 75 IEffiiE N IDxxx-QB-EZ ¥ 1) , EZIEM-1_E 20 (a3 -4 (Brk)
RS WRAEIDXxx-QB-EZ# A i BHa TR, WEZIEM-14¢ 387~ 4] (Run) 43 &1
5%, RINLLEAFR7RAT (Brk) 482K

FFR1 bl B ERETYR, PRI, 2 06.1.57, ¥ 5 #badgell) /4

http://www.cn.necel.com/cn/Badge2007/connections3.html

TFR2 FEHRIHARR

H. A~
G

s, WTERERPIN T 2AMERG &, IPRAIZITRITAE ON L & .
RENS SCHF I ANV A 2035 1 B F RS ARGES A A 20 T M

TFR3 B HARR

H A~
5ot

fEHIEZIEM-1H A FRIN B S5 (2 H8MHZ), U RIERE ML

A DLBE AR, WERZOT R4 THE"Debug™fr &, Al LAAE i

WA NI PR . WRZIT R " Stand Alone™ 7 &, MRESETES,
R4 B shigdT, BIMEEZ/EM- 18R RAE HFrti L
FEoRA 0 H bR RS HEIRAEN,  anBE BN Wik KT G N SRANTE T, B 2R AR
PR, ONEZIEM-1IREREN B8 13N, — R UG H bR RGEARHERE S Ui

#6-6 {HEMR MBI K EZIEM-1 [KTFR4A A5 0

¥zl | EZIEM-1 | EZIEM-1 | EZIEM-1 | EZ/IEM-1 EZ/EM-1 Mini2 Mini2 BiL
g~ | BHAER | BEHR | 1644 | 164HIR | 104K | B5 | WR | T
J7 2-3 2-3 2-3 2-3 9-10 2-3 2-3 1-2
J8 2-3 2-3 2-3 2-3 9-10 2-3 2-3 1-2
J9 13,24 13, 24 13,24 13,24 13,24 13,24 13,24 13,24
J10 TT TF TT B TF TF IT B T T
J11 3-4 1-2 2-3 1-2 X 2-3 1-2 1-2
J12 3-4 1-2 2-3 1-2 X 2-3 1-2 1-2
J13 1-2 1-J14-1 12 1-J14-1 X 1-2 1-J14-1 1-2
J14 Tt % 2-J13-2 TT % 2-J13-2 X Frit% 2-J13-2 TT %
KA Off On Off On On Off On X
TFk 2 Off Off Off Off Off Off Off X
JFK3 Off Off Off Off Off Off Off X
x4 On On On On On On On X

WO NI, RAAAMERG A . RS I 1A AT 10 BHE .

2. " XRILHHE.

58
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5 6 Qi EZ/EM-1

6.2 EZ/EM-1 FFiER

6.2.1

At A4

[=]
L=
-
=
o
{ = A |
=]
o
-
el
=
=
L

& 6-12 78KO/KF2 (¥ H¥rtk

78F0547D. 45 8 44 11 16 443 L1y Rl 7 .

43
{ieYeYeYeleXeXeXe Yoo )T
NEC (00000000000 LBK
. _UPD78F0547D T8KO/KF2
'O O Ok ”EE! 20 0=
~i0 O} (MmO & 0 O
e lelin i L 40 = 'O O]
Sl00 .= . & ool
20 O} < o 100
=00 2. o 100
SO0 = < (00
=10 O} 80-= L2 21 51 10 O
10 O} (LTI = 100
zi0 0l QTR wRlo Ol
f = -7
:-3©In LS [ R
i E efeYeke oXekokoYol L = |5
i 15 000000000/ w2
:E:E [0PEN|DEBUG/DIAG, (PROG o | HE
.___:_J IJJ.-—ULHE” J E:E
Hs I olzloo]o 0ok &= | LS
= 20500100050:_
B=32enos [T 5k | Pty = = 312
== TEEIEITINL FROG(Minicube J2-3
==[DEBUG |13 2)-(14 2)| [OTHERS 14O 0 QO
JILiJ12 PROG " O L |
2l OO00000O0OO0O ||
|| coooooo00 |hsf0o0COOOOO0]
1 I J1 ELJEN-1
CNl MINICUBEZ

6-13  MINICUBE 1/ ELAR [ #2 25 [ Mg £ 1 . 3 1

EZEM-1 $53F

SRR EZIEM-1 e 2 I oy 45 5 H bRk, fdsidil#s A NEC 1) 78K0/KF2 FR 4111
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b 16 411 Flash-Programmer £ 1142 MINICUBE2 & #:100, CHrES A gnfiThft. St
THEEREAH KR, EE/EHERREN, LA™ LED B nT LEH .

6.2.2 78KO P EMRAIEIR

ARICEFLLL 78KO A, T EALE FH Ak (R AR, 78KO 1 BB 78KO0 2 Wik, i AT
P TRESCEE, Al Applilet2 for 78KO0 45 T H A i, 0 REIBREE AT BT S & 6-6. {1
FH R4k ID78K0-QB-EZ.,

EZ/EM-1 [ 4k e 77 X — i 0 HE L 4 30 H ArAi . A 8 BHHEiEs: EZIEM-1 F)
HARARIN, VLI, & SIS,

PRI EZIEM-1 B I IF AL B IE S % 6.1.7 11, RUsiTHIREn, o LAE 2 H AR -
A LED BA 2Hz (S A8 8 Ntk . BRI 5 it 2% 50 7 2%

EZ/EM-1 BRIASZHF 78K0, (HIE MR Z Wi EZ/EM-1 X5 1) R BB A HEAT b4, 75 22
A9 40 R i A SR 2R AR Ok 78KO.

PR AR S50 7 SN

SRR I, AT LA Sl B A T RER AN EZ/EM-1 J& 75 BE 68 IE A AT . IR hREMIAE
JHIESH M A IS _‘

e

1 91 78KO0/KF2

6.3 EZ/EM-1 HTHBEETS

XERET AN RS b gs, %0 d AN R AR, - RIS AT X, X
B2 AT R PR
&K 6-7 MK Z AKX 5

Tk WriteEZ2 WriteEZ3 WriteEZ4 FPL
pAINEY] 78K0S 78K0 78KOR V850
YA nf LA nf LA nf LA AT
L5ans ANAT LA Al LA Al LA Ar LA
PGPS, AN LA nJ LA Af LA Al LA

ER: KRTEH EZEM-1 AN RS AMERFI, PRSP BRI A ELIES % NEC A
KIAR R T o
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6.3.1 78K0 AistRHIgIELES

F 6.1 I R E R I E EZIEM-1 [T 5501 BE Al 4 FEke s

TEAS ] 78KO 15 5L T, JEAT S fE i (R4 5 TP oG s B AR D e —FF, sl (HAEA AT
(R RV, 50T e B A A i A L

L UG 1) WriteEZ3 #fian

EWriteEZ3

File Dewvice View Help

PR Y4

FPCOMMAND: AutoFrocedure (Epwl [ Device
Flash Blank Checking. .. Hame : DTEFO547

chip blank check finish.

skip srase. | Firm Z.00

Flazh Programming Start. .. | ExtCade TFO4TCh

Flazh Frogramming <10%> .. Tetder a 10k

Flash Frogramming <20%7 . . Faranater Eile

| Hame : TEF0S4TD
Format 0414
Yersion ¥i.04
Processor 0200

Flach Frogramming <30%> ..
Flach Frogramming <40%> ..
Flach Frogramming <S0%> ..
Flach Frogramming <BO%> ..
Flach Frogramming <TO%> ..

Flach Frogramming <B0%> .. Load file
Flazh Frogramming <90%>. .. | Hame A HEX
Flazh Frogramming finish! Date @ Z2005/03/25 16:57:24
Flazh Internal Verify OK! Chlesum DZ5Ch
Area  000000h-01FFFFh
Connection to dewice-;
Fort COMS
| Spead 115200
Range Chip
| Freq. &.00
Multipl 1.00
|
Ready M

& 6-15 78KO/KF2 B FRHR 1% T FLH

iRGiR G, Bk EZIEM-1 2 HARIIEL, K54 HARAet 5V, HARBNZ T Ll B3l
THaGATR e, A ) H st LIPS LED BL 2Hz IR AT NI -

W% BV IR, WaTLON EZ/EM-1 EZh 51 Vdd JEE R R S s i i, S1h
GND 382 2 il il i e o XA (436 A sl T ALE FARARIBEALIZ AT

6.3.2 78KO i EMKImIERT
78KO 1/ ELAR [ 4w Fi b8 55 T BAE ] WrriteEZ3, FAKIKBE S HCE VR 1S %50 8 N

B

AT EELL T8KO A, it S FE A ATk A id 4, 78KO0 7 BRI 78KO0 2 Wik, i il 78KO0
XEIV T hex SCHF, X6k I Rk £k RN 5 158 B 5 1) ¢ 6-6.,
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] 6-16
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58 m AR

BTE SRR AR

AR EA-F A8 1D78K0-QB T FFRF .
7.1 ID78K0-QB-EZ§%E¢'T~?B

711 REEE

JA 5 ID78K0-QB-EZ AR IA Y f5, 1o Ew BRI E i O, hH R A 2 r Hbx
Ml B K% E ID7T8KO-QB-EZ $ATIN IIFAEE . BB Amin -

Chip —
Hame: wPD [TEFOS4T 60 0K

Cancel

Configuration

~Internal ROM/E&M
Internal Ter————
Froject. ..
¥ Use Ban About. ..

Internal high-speed 124 *| Byte:s Help

Bestore

Internal Extend Bytes
Main Clock
" Cloclk Boar {7 Externs (% System 4.00 w | MH:z
(" Clock Boary € Externa € Syste
—FPeripheral Breal Monitor Clocl Targzet Power D£f Foil fe Breals;
(" Brealk (* Swztem " Fermit
fo Hom Breal " Uzer {o Hat FPermit :
—Mazk |
[T WATT [ TARGET RESET [~ INTERNAL RESET [ i

Memors Mapping

Memory Mapping hdd
|Target ﬂ I o Delete

K 7-1  ID78K0-QB-EZ ] Configuration % i HE
Chip EHS R8s, ARSI AT 2 238 1R e AT o
Internal ROM/RAM AT (35 ROM A1 RAM K/ o ERIAE AR BT 126 1) 05 1M 42
o AT EIN A DB SN A7 R, BRAEAT IR A 048, DA
AR KB ), AN
X1/X2 Clock LA E] X1/X2 5 e, R nahaedl, WRzak e
4”System”,
Peripheral Break F 8 ERE PP T AR AR AN BT L D B 45 1k e o IR & Wi,
TEWT RUARE T 1S 2 21k
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08 m AR

Monitor Clock PR R IR B A I
Target WE HIRBUE B HOE I s
Mask Sl HARASCR S BOAH SRAR 5, B DR RS 5 oV BE U By . — X

FEVIABT B HARBRAEARRE A 2 IR PR DR ik -

X RFTIT ID78K0-QB-EZ [1J[FIHf, PM+ AT IF 1, 41X A~ Configuration X iFAE 1
) Chip JE K, TEIEN, HBERE PM+ 41T TR S A S,
WHETEHE, mi"OK ], ¥ Wor ID78K0-QB-EZ 1) 3 % 14 .

ID78K0-QB-EZ

File Edit ¥iew Option Eun Event Browse Jump Window Help

(o[ [ = e[| = | (|| el Q|| Befea(m| B8 (W[

- - - - -~ [no1pc i |in= ' d
Kl 7-2  ID78K0-QB-EZ # A 4= 5t
U AT TR, 7T A" Sre™ 4 A K A ) o
miili"Option->Debug Option”#t n] LA IS £ 11, Wik Jios:

—
Debugger Option |X|
—Source Path ~Tab S1ze
Base: C:%. .. \Litangshan BJNEC Extensionfy # -
l Eroﬁse...l Tab 2 T4 &g
SiTer
~Tefault Extenzion TT;&Ef ::zsm g Add
Source k. ook =% asm *. g
File ¥ g b Delete I
SO [ Lok #. Inf
e '_ - —Startup Reutine
~Open File History ~Fant Bevin I_@cstart
e 4 - i e, R B
f:!:.}\]{.Hwnber ] I-_-"_i__,_i Font. .. | End lahel: l_@cend
~Project File _‘m&in_p I_main
Auto Save: (" On 7 Off & Query —_]:Ii_s_ﬁ;;;amble
Show [~ Label [# Mnemonic
: MNff=at-
~Source Option Regizter (¢ Function Hame
¥ Bring up source window when break Haricy AT e e
~Tool Bar Pictures ~Kanji ~¥atch Default
(" Picturesz and Te f* Sjis Sl;eiBytE ..v_] RadlE;Hex .;‘
; Show Variable " 0On % 0ff
{* Fictures onl { Euc Trrma-
Language: o C £ ASH
0K I Cancel i Bestore | Help |

B 7-3 AR 0 X TR ATE S T
HIRZ W S 505 B IX g . AR #OR U T A 4% 4L, 54 45" Tool Bar
Picture” &+ Picture and Text”, XFEMITEREANZEL N J7 A 0 N 1) SCF 47 o
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7.2 HENH
4 ID78K0-QB-EZ (1) T A &N A4 .

W A7 HAFE B 1
! ] ]
i ID78K0-QB | o ] 4

&
File Edit Wiew pol tion Run Ewent Browse Jump Window Hdlp |

e » = |-|H|»I|‘| B8 e |I|$|ﬁ| A (B =8| b3l A

I Source (main.c) =loix | =lo x| | =10l x|
Search .| <4 | > | Katch | @uicl||search .| << [ 13> | Refresh | 1o ||[Hew_ fper | [ rabie | [ Delate
- = _— — |
oid pain (1 Al aadr+n +1 42 3 4 +5 +6 + [EJ[Evooo0t |
| 0L 0 EF 00 DF = |
| LED Flag = 0; /% I FF 10 FF |
DD 10 5F C
| PHL &= Dw?F; ¥ S DF D& 78 C
PHE = D=00; 4 5 FF 06 FF

FF 08 5F [~
FE 00 D7 2
AF 00 FF (%

» A »

RT=TET] [~ veomter - i0i x| T =R
_ & |_»» | Wateh |@Quict|| Refresh |fodify | Close | |Refresh|“odify...| Close |

TCLE0 = Ox07; Tr]l
CRED = Ox15; f* Cl
1, R # TlJ

o

[@cstart 2] || Rezister 0= Current ID_
— Pl BT 1.8 00 |
P2 iz 1.8 an
E3 E-W 1.8 an
P4 R~ 1.8 oo
133 E-W 1.8 on
LI P& R~ 1.8 o3
2 P7 R~ 1.8 an
| = | ADCER iz 16 | A AC0D
— REEG i g FEF
<] | | I3 | | Bty B o | P
|main | [BREAK] | | W
I I |
Y 23 Dz =z 4 S =3
9w T 1 AR IR Ay A s A

K 7-4 ID78K0-QB-EZ M&AN%
HA i TR AU, A B 148 2 B0 PR TAE AR v DA I 28 3240 SR sE 0
AP EZIEM-1 FTANSCREI Dhfg, a0 S5 24 X 28 s g Dh gk i, 154 H IECUBE S5,

BT (ERLT ) WOCHEED AHERE Wt R A
| JU R ‘ ! . |
EHEAT | ABIET | M IME SO AR REBARE L Event B
| | | | |
| | | | | | ! | [ ! |
t t T t T : ! 7 - = =
S{:p ReGo Q::v (:: ﬁﬁt Step ip.vir Res E&n Lg:l 'EFJ I;%n hﬁ 'I(L;czll'v F:;a;; @ | th | %rW H:'n Bl %’c % |
IR R i
I AL IstT . oo Watch 7 I s
N N | AT LR |
| | (RREAES)| | | |
kst REORM HTIFTR LA 1O RAERE O Event X i

B 7-5  VHA T HA 4% B B
7.21 FEAFXH

HUARSCAF A H T R Py 20 132 B — ERR B BER S, i e 2= Imfo 5 T4 1% H AR S
PEITE, PRI 6
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& IDT8K0-QB-EZ
E

BN Edit Wiew Option ERun Ewvent EBrowse Jump Window Help

Open.. cero lgm| | o) Q|| B[] B[ 8|V

Save As...

Tpload...

Froject »
Enwironment L4

Debugzer Rezet...

Exit

oot

|
K7-6 FEH BRSO

|ins

722 mESCH

— N TR R, WSS AEETIT main = e BT LS R SO . P SO TR H
T CIEE L gniE S AUS S, ] LU gl gnis S e (s 4% 0.

Fn# SctE, kPFile>Open...”, #77F Open XfiftE, ID78K0-QB-EZ rJ LA ¥ fh. 1E$%

BN S, ST, SR ngk 2 ID78K0-QB-EZ H, Wi K-

2 ID7T8KO0-QB-EZ
File Edit ¥iew Option Fun Ewent GEBrowse Jump Window Help

[i]on| | Bl || e Qla|wl®| =] =] o]

| % | Wateh |Quick .. | Befresh | Clese |

e hbstract:

e This function implements main function,
b

prse Paraneters:

e Hone

{27 Gpstemn_user.c b e

(L1 systeminit.c b e Returns:

(] Timer.c I s None

] Timer_user.c 0
b

b/
?Jid mainf void )
/x Start user code. Do not edit comment denerated here »

THOO_Starti);
while (1) {

/= End user code. Do not edit comment generated here =/
i+

/= Start adding user code. Do not edit comment gensrated here »/_|
/= End user code adding. Do not edit comment generated here =/ =/
=
3

»

[ | |

Imain, ci66 Inain o1EA | ins [ A
K 7-7 ID78K0-QB-EZ JE /¥ 7
7t ID78K0-QB-EZ At & b, A2 BonARit, 2ok WosiiilE A
WRAE BB A5 i R

* BORAAT A RAGAAT, ZAT AT LABCE W
> FRPEF U TRATIIFEAT . U7 B A 3.

oy BT

FEF SR e, I R FSR BT C BT ME, ARSI gmiE ), Aan]
PLAESCCAE o FHE Ry A B, 0 (02 X Mix”, sl LLR 31 C i 500 I T AT
G iE ) o

66 EZEM-1 5 SF M



58 m AR

7.2.3  MEILFEXH

TR Coprp) W5 T D TREMIAER, Wil 00 st & DAL EA
FRRCE o WD IN g AN TS IR 1 TRE SO, AT DU (R S R ) T PR
- ID7TBKO-QB-EZ |
EnEdl‘t View e == . 5 e el ¢

Save Az...

Cloze

5
B

Option Bun Ewent Browse Jump Window Help

Download...
Opload. ..

Environment Save

b As...
Debugger Reset... TS 25

Exit

|001B4

[
K 7-8  ndk LR
BN RSO, R File s b )" Project > Open”, 317 Open %HEHE. EFEB N
AFA, ST I LR AT

7.2.4 FEFEHHEER S
FHTREF ZIUERAT — kRl bR A S, sifE AT s T . X, ﬁ%Ew

mWﬁIEﬁWéWB’%T&Emﬁ?*A##MHOW%WﬁK%%%‘ TAIT, WA
N KA QRN SR EAE S B T AT, B AMATR R (.

Imain. c#68 [

A

_ 4| 3| Wateh | Guick .. | Refresh | Close |

s None

I 0

I 0

b

/

e __interrupt void MO_INTTMOOOL void )
ysterm_uger.c

(1 systeminit o /* Start user code. Do not edit comment generated her

PG, 0=IFG. 0;

/= End user code. Do not edit comment generated here

i

/= Start adding user code. Do not edit comment denerated here_l
V= End user code adding. Do net edit comment generated here »¥
-
%

Ll |

|Timer_user.c#d5  ND_INTTNODD  |DOZF4 [ |498ms 200us |Software Break /J

K7-9 B

725 PITERF

R, e Ll e, s RunS Gor.
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Jikige Event Browse Jump Window Help

Restart F4d
Ignore brg points and Go  Ctrl+Fh
Feturn Out FT

Step In Fa

Negt Owver F10
Start From Here Shift+Fa
Come Here F&

Go & Go

Slowmotion

CPU Reszet Fi
Change PC Ctr1+F8
Software Break Point Fl1

Delete 411 Break Points
K 7-10 HATFET
FEFFHAT BT AR 2541 b . B, HAFR A "B br 5 RI] .
A — NI S IE AT RE, 5" Run=>Ignore break points and Go”, ARG H £ /bt
M FRIPHIELIEAT, SeA R fE

Al EE AR T AL EAY Step In }“;‘%%Hil, B2 FERun>Step In”, HEAT BT .

“Step IN"FEHAIE LA —AT1E R — LR PAT, ERRECH, WIREN R EARRS, BT
17o "Next Over™fi it & s SCA 1 —AT 1 — kAT, 7ERREOR B RAL, A R HUE D —
A RIAT

FERE AT W10, i‘“ﬁ@iﬁi%ﬂﬂ, BUEE R Run->Stop”, 1] LU IEFR AT .

726 EfL

TR A AEAT , Hn] AEAT R R A E‘J?‘i?iﬁéﬁ??ﬁﬁi‘ﬂ%ﬂil, HEIE R RUn>
CPU Reset”. @ ilAERE A5 IERAT INREAT H IS #2455 0T g2 5 HEEAEAL .

i@k Event FGrowse Jump Window Help

Eestart F4

Go Fa
Ignore break pointz and Go  Ctrl+FDH

Eeturn Out FT
Step In F&
Hext Ower Flo
Start From Here Shift+Fa
Come Here F@
Go & Go
Slowmotion
Change PC ! Ctrl+F93
Software Break FPoint Fl1
Delete A11 Break Points

7-11 HEH

AT CPU A125-4hH Macro #IVK EANUAIRZS . AT A A7 s A UG H -
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727 WEMBEHTEE
s AT 2R B Watch ﬁ%%ﬂgl, Bk $EBrowse> Watch”, FFi5 Watch XiHHE

78K0—-QB-EZ = [B]X
File Edit ¥Wiew Option Eun Ewvent BaiEalEr) __lu.mp Window Help

“1",1’ l'ulzl*‘l’”lﬁi @Iml! SourceText

A=zemble

Memory
ETE—
* Register i

Sfr

Local Variable #i

Stack Trace

NTTHOOOL woid )
2 systeminit.c =3
% Tm | Cop=ole

Others
e ode. Do not edit comment gen

code, Do not edit comment

% 3tart adding user code. Do not edit comment QE_.!
* End user code adding. Do not edit comment gene ¥

'__%I
l¢| | 13

|Timer_user. c#A5 MD_INITMOOO — |O0ZF4 [ 1499ns 200us |Software Break A
7-12  #TJF Watch % K
H—FTIT Watch & 11, AN

fill | | 13
K 7-13  Watch %
76 B s Watch 2 TR Add. . F5 L, 3 R In AR B HEAE
FEXHEHER) Name BSR4, JEFOK”,  alh ] LIOLIN B2 5 (K 4 i . B R 4k
17, A8 (e AR 2 B S R HT o
Hgzia A s M AME T LAHE Watch % 1, gl @ /RSSO 3 g b AR s (A 0, AR
AR SCE R 1 7 (K" Watch %81, gl il LA AR S 78 i 2 S 7 1A

BXZRA:
£ Watch & AT 22 A DI, S R BN B SO e (e, 2 P4 B A B .
R, AT AR AP AR IS R B, 1A FEPON USRE AT 1 ORI 23 75
HUEHE SN WA o 20, 4% R IR AR, AU s R
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7.2.8 WENEHEFAERME
ﬁﬁ%ﬁ%ﬁﬂ@ﬁﬁg,ﬁ%ﬁ%?mmméR@mwﬁﬁéﬂﬁ%ﬁﬁﬁﬂo

ile Edit View Option Eun Ewvent B

Ul i"i Lt 1"» ! = ! *il»il ..‘.! Ei@i@i Sourcelext

Azzemble

Memory

Yatch Refreshi Close i

E] main 3fr
{Z7] option.asm | Local WVariable

[ Part.c: Stack T
Eggyﬁemc Bk NTTHOOO! woid )
pstem_userc :

[“_'Is;_lsteminit.c | L OVEerage code, Do not edit comment
Conzole
Others

ode, Do not edit comment gen

# Start adding user code. Do not edit comment QE_I
* End user code adding. Do not edit comment gene ¥

4| |

\Timer_user. c#65 [MD_INTTMOOO 002F4& | 4989mz 200us |Software Break b

B 7-14 FIHFFaED

WML FFAHE:
Mty "+ (P A Ar 4 4 5, 0l UG B35 A7 28 & 1 E
AE

 Register

Refresh “ Cloze .-

[-ax FEFF
= FE
FF

K 7-15 FFfrastd 0
FEAAE AR B 1, T LB IR A e IO MEL, B0UR MBS Z0 e, fmI A, B Ros
A Ef,
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7.2.9 WMEIL4%HHG

ID78KO-QB 17 LL 5 % FE ¥ 0 00 4 AC B3 . Aok O 4 o O g o ), kR
P Browse>Assemble”, I IFIC4%% 1.

File Edit ¥View Option BEun Event [ Jump Window Help

B|.4|

Memory

Watch
Register

Sfr

Local Wariable

Stack Trace

l Refresh i Gl

NTTHOOOU void )

Tra

code. Do not edit comment ¢

Others L4
— ode. Do not edit comment gen

i

/= Start adding user code. Do not edit comment ge—
/* End user code adding. Do not edit comment gene ™)
o

=

< |

[Timer_user.c#65  ND_INTTMOOD  |002F4 [ [498ms 200us |Software Break /J
Kl 7-16  FTHI S 0
s (L Source & I piii bR A8, SRS /RS S LU £E" Assemble™ i) AFT T 4 & H .

& IDT8K0-QB-EZ
E

N S N R T = A e T E S N - ST e )

H=lEd
earch | << | 5 | Wateh |@Quick .| Refresh| close |

[ MD» INTTHODO Bl PUSH A% -
4100 MOV A, #0H —

ile Edit ¥iew Option FEun Event GBrowse Jump Window Help

2C0ell BT P 0H,$_MD INTTHOOO+0=7

41 INC &

25 RORC 4.1

710106 MOVl P& OH CY
systeminit.c

(1 Timer.c 2%0601

&

Timer_user

P& 1H. $_MD INTTHOOO+0x1l
INC A
RORC A.1
MOV1 P6. 1H.CY
POP AKX
8F RETI
11nAN1 HOW PA B1H

25
711106
p=li]

(Timer user.c)

J e e |
-/

__interrupt void MO_INTTHOOO( void )

/* Start user code. Do not edit comment generated
PE.0=!PE.0;

/= End user code. Do net edit cemment generated he

/* Start adding user code. Do not edit comment generated h
/* End user code adding. Do not edit comment generated hera
3

4 |
|Timer_user. c#65 MD_INTTMOOO ~— O0ZFA | 499ns 200us |Software Break ,d
B 7-17 gmeE
Sy T 2R AL, ZEMDE R B, A /S RORILgm i 1T, nTDAEA AT B E
Wi ">“fF e RN METHUTIIE AT, Bon s, "B RoRTE A k.
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7.2.10 BWEICIG¥S

FEMLHEAT 230 007 Dt o B 2B, RTRUIA MWt WA AT— N7 B AR . AT
7.2.4 4791 Source A& I —HF, BB W AT WURAE AT AT AT, A BRI At

&5 IDYT8KO-QB-EZ
File Edit ¥iew Option Bun Ewent Browse Jump W¥indow Help

[ fen > o | =[] = | |8 D[S Q|| B B[ 4|5

| % | Msteh |Quick . | Refresh| Clese |

120000 HOWY
B0 PO

F] | MD_INTTMOOO

A, #0H

P6 OH. $_MD_THTTHOOO+0x=7
A

spstemirit ¢
8 Tj;mel . 2 a1
] Ti = PG OH CV

P6 . 1H. $_MD INTTMOOO+0x11
i
4,1
Pe 1H.CY
AX

| PORT _Init Pe, #1H
FMe ., #0FCH

A]

| Clock Init OSCCTL, #0H

HSTOP

]
| CG_ReadResetSo
F1
< |
Timer_user. c#65 MD_INTTMOOO |002F4 | 489ms 200us |Software Break

7-18  BLEIL TR

PUSH HL
HO¥ A, RESF

,ﬁﬁia‘zﬁﬁilﬂﬁiﬂﬁﬂ?ﬁ%ﬂﬁhﬁ, FEFFSRAT BT A5 0k o AR T 7B I B (g 47 R ]
FEFF AT I 2RI

+ ID78K0-QB-EZ

« Assemble

| | >¢ | Wateh |@Quick | Refresh | Close |
002F] HOVW EBC, #0H

Bl main 00ZFY FOE A1

{1 option asm 002F7| POFP  HL

1 Pert.c 002Fg & RET

1 Spstem s 002FS||_ MD_INTTHOOO FUSH &K

{2 Spstem_user.c 002F4 A MOV & #0H

Ba wpeteminite 1nzFd BT Fh OH. 3_HD_TNTTMOOO+0:

: 00 2FF 4 INC A
00300 2 i1
00301 P& 0H. CY

-

A #0H
P& 1H.$_HD INTTHOOO+0z
A

A1
P& 1H.CY
AE

13
| PORT Init
3

P&, #1H

FHE . #0FCH
Al

| Clock Init OSCCTL, #0H

HSTOP

RSTOP
MCH, #0H

[Timer_user.c#f  ND_INTTHMDOO  |00304 ] [ins [Software Break /

719 AT EIWT A
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BB 45
5 Watch & FHE A 2K BL, 7F Assemble % 1] UE MRS, BEUNTe4 A4,
A BIRE 2TIPN T

7.2.11 iBHID78K0-QB-EZ

iR ID78K0-QB-EZ, #EF% File 321y Exit, HILE HHR/RXTEHE o

ID78KO-QB-EZ

9 This will end your Debugger session.
‘-—Trj Do you want to save the settings in the project file 9

7-20 iR HGIEHE
W] & 75K ID78K0-QB-EZ Y715 ¥ A IR 55 15 B ARAT A — AN PR TRE SO R a2 oY),
T IDT8K0-QB-EZ 1}, W] LL# ] O R A7 IR IR e

EZEM-1 #5595/t 73



F8E TP RN

REEANFWAE ] WriteEZ3 2w FE 48 H P FE P g AR B il 28 v . WriteEZ3 #BA4-40GE H
T 78K0 RAUTHRS, g2 Al RV (5 3 T A R A, 1A N Y R G R A
8.1 WriteEZ3 [IEC &

M WriteEZ3 F)223%% H 3% J5 8) WriteEZ3 ZwFE 544
AT R R 2 )5, f8iHT FahicE, AR A Al HPRH & R 35S WriteEZ3
PATI A EE . BOE SN, U Sl B AR Nt

Standard ]Adva.nce ]

Parameter TBFd54TD.prm FEM File Read

Host conmection- Supply oscillator -
Fort = Frequency I3.00 MHz
Speed | 5o ; Maltiply 1.00

~Operation Mode

(e Chip itart .
" Block Fnd |! d

£ fres I

[~ Targzet Keset Message

wE | B |

P 8-1 WriteEZ3 1)1 % Hi & S 1

7F WriteEZ3 =74l K, fidi’Device > Setup”#k N WAL & AL, WA E EE0 hin
=AM

1. SHCmE

7t”Device Setup”(f)’Standard” 7|l F, s5iili"PRM file read”, 7T F#&Ja il A7 (E A H 1)
SR, P H bR L 78KO S A FR. IkAbiERE 78F0547D.prm RIH] .

2. i kR

7E"Host connection”[#]"Port” I [ F HHE-H £ PE EZ/EM-1 458 FH (1931 1 44 F5K o o8 55 3805 i)
4”115200” .

3. IRG AL

WU BT MR 2%, WHE ] EZ/EM-1 & 4R 5%, N i%dE 5 h 8MHzZ.

78K0, 78KO0S F1 78KOR R FIHS & A st g, B LA"Multiply” #5345 4717, WA V850,
A [ AH DG TR B A S 4

4. FAEBGK

— AL R A, IEBEChip”. W T B B AT, W5 IEFEBlock”.
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B WriteEZ &1 % B AR WriteEZ3 7] .

URBEAEBAT BENS IEFIER:, PC I RBBER M H A L 2, W K4l Device
A A5 EZIEM-1 1 HARBOESRERIF UG, 128 UGS A5 &

Wk L " Parameter File 347 W, 5 RBEE il (WSHCE, AAIrikES% 1.5
T

7t"Device Setup”iJ"Advance” Ui [, S HF < abn ks, —RIETSEE).
“Command Options™#* 3= B4 & 4 F 11 J 1AL BEGFE o

“Blank check before Erase”#% /s fE# [k # EPV (BERmFEIE) Z /1, Sk aEa® h=s,
WR R, AT EERR .

“Read verify after program” & /R7E4m e fi F ST R SAE,  IXFE AT LAF - g e g M JEAT

“Security Flag after program” & /s e 5 i m H 805 N2 bRk .

“Checksum after Program” /R 7E g 56 il 1 IR AR 50 A& 75 USRS, X e gm e 2] H bR ik 4%
R I A REL S S R R ORI A . AN, SR s A

PA

Device Setup El

Standard Advance |

— Command ophionz
[+ Blank check befare Erase

[~ Read verify after Frogram
[~ Security flag after Pragram

[~ Checksum after Pragram

— Securty lag settings
[~ Disable Chip Eraze

[+ Disable Block Eraze
¥ Dizable Program

[ Dizable Boot black cluster repragramming

[ Target Reset Message

Ok I Cancel

Kl 8-2 WriteEZ3 [ = e %] i AE

“Security flag settings”#* ¥ ¥ & 4 f2 & 4= 1.

“Disable Chip Erase” &/R AR ImFEsE NG, 8 "Erase™ 22 R3L, BB R — Ak
BT b, DUERNZES R R, BN RS NR CAT Eis A0 R B 5 5 .

“Disable Block Erase” &/~ A g F2 5 i » £ Standard ULl o BT [ ERES TC V4404 T Erase”
ZARE T LGB, A BRI AT

“‘Disable Program”&/mARGFETEMT, PR 2R3, FiA PR 2 K. 1ZAn&n]
DA B, A3 5 BRIy
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BRI BREEBR AT & G F i 2
ARG | B T A2 EE S
SR DU ER B R 1%
2 b i 113K L P

8.2 FEH M
G LR File>Load”, &t nl LAk N2 SO F i . vl LASCHRF SCARR AT = *.rec
*hex, EESERUG, 76 ERHAM K Load File ki n] LLE 3| s 8 e Bk &Lt so it
BN A] . RSN, DA A R A

TH 2]X]
HHEEEA D [ demo x|~ Bt E-

Ifﬁ inc
() source
||ﬂ a. hex

i@buzzer. hex
!@ option_byte. hex

e [ EETN
TR (T ]S-rec { Hex files [ ree:* =i% hex) __..] ﬂ

8-3  WriteEZ3 (1) 30 3 i EHE

8.3 HATLHIE

WIHSEREE A, 76 Af i Device > Autoprocedure (EPV) ”, BRI BL— 7k 58 B
Mg R I X =M EE . SERUE WriteEZ2 2375 3 FL i & K 51 AT K5«

BiWriteEZ3 M=:3

File Device ¥iew Help
= . [P R
g & [)

PHCOMMAND: AutoProcedure (Epw) [ Device
Flash Blank Checking. .. | Hame : I78F054T
mot blank, then erase.
Flash Eraslng | Firm 2.00
chip erase f1n1sh | ExtCode : TFO4TChL
Flash Frogramming Start. .. | Vandor : 10h
Flazh Programming <10%>. .. = = Tt o
Flazh Frogramming <Z0%>. . . | ¥ = TBSI:.D?;TDEI’ Bk
Flash Frogramming <30%F. . . | Fame 2
Flash Programming <4087 . St Uald
EoAinE Yerzion ¥1.04
Flash Programming <50%>. . . | p 0200
Flash Programming <BO%>. . . [ERERA50E
Flash Frogramming <T0%>. .. - Load file
Flash Frogramming <G0%>. . . | Rame & HEX
Flash Frogramming <00%>. . . | Date : 2008/08/25 16:5T:24
Chicsum D25Ch

|Area  000000h-O1FFFFhL
Commection to dewice-

| Port COMS

| Spesd 115200

| Range Chip

| Freq. &.00

Ml tip 100 |

I

Ready |
8-4 ID78K0-QB-EZ f&)7ia T St

76 EZEM-1 #6 5 F1l}



5% A OCD checker

N T IR, ARFEAER

fi3A OCD checker

OCD checker 27 1] A7ERL £ 4% \Software\OCD_Checker T 3k14.

OCD Checker w] LU T 22 H T4 KI5 H

FH EZIEM-1 G255 7R (F) 78KO0 1) ELERCRTZ Wb ok HE4T E A o

Rrus A EZ/EM-1 78K0 78K0S
78K0 V850 78K0S | 78KOR | MINICUBE | MINICUBE+

F bR J X X X N J

Hir R PR X v X v N N

H s RESET 5IHMRZS v v v v v v
RIS 7% J J J J N N
ID %1 X N X N N X
flash f7 4 3 0HE T3 J J J X N X
FUFIEIT v v X v v X
BRI N N X N J X
#E N ATRASCRE: X RSCHE

A.1 OCD Checkeriiza{T

1517 OCD Checker Z B 224fiIA L& f5 1L A, dmfi Bt GUI LA EZ/IEM-1 [ F K2 T
Ho MRS T (1)30(6) 0 B T 2

(1) EZIEM-1 (&

EZ/EM-1 [P FF R NAZFTAEXS N H bn s AR GES %5 6 50) &

() i EACRTZ Wi 1

GRS

EZEM-1 $53F
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5% A OCD checker

[

i
i
UPDTaF 05475'-?-;}'.-

-
==

v
o
z

e T e e
=  JI1SONSYIO '“EE.-]{‘D t'jEG

K A-1 78KO0 fij EMFIIZ Wi IE B2 K

(3) ERLLL A RPN ]
¥ EZIEM-1 IE 2 HFR RS, HIs RGEBEEICE N 1Z A GES%T 6 ) , R

JRATTT HFR R GETT K.

(4) ¥ OCD Checker
o i ELARAR A X Ik 1% "EZ emulator 78K0”
o B FEIX J: bzl il
e N7 ROM Security i B [X 1 Hin ID ARY
o [HAESCAEAH R H &S0 44 5 DA stk

78 EZEM-1 #6 5 F1l}
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(5) A[TESTHEZHL. W AAS I N A AR R, 1525 i A Ab B

= 0CD Checker

Exit |

Mode of the emulator Target Dewice Conmection
Z emulator TEED Dewice _i Port]
Cleck —Internal BOM Security
(™ =zocket

_:J

Test {* interna 1o Eodel.:....:....:..-,:..-.:'

Log file D4 est \TEOCDUTL, 1og

15:02:32

Target Clock: 4. OOMHz [0K]
Target Reset: HIGH

OCD Control Code ¥2.00
MINICUBEZ 4100 & %4.05
Frogram Download: 0K

Fun Test: 0K

Flach Erase: OK

ALL OFE

Emulater Test End

Clear

A-2  78KO i EAR I IE A 45 1

A2  HEIHEHER

X A1 i GG, R

o JEATHH: 2 [TES T LT 4R Fr i 1)
o IEPIRE: Ik B B A
e Reset R RESET 5k
[i=4] HAR RGN Reset 55 4
[fi] HAR RGN Reset 1555 A%
o THPENRA: 0 3 P PR A A ) &5 2R
o [FP F#]: ID AUE, T4 Hirik s flash it gL
o [iz47MA]: 1847 DL R R i 45 R

o [Flash #4] HAni 4 flash 3R 45 5
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A3 B E

HR ] e E B R (BN BEE R DL N I A AL BRI R R TR
R SRR AR, WA RE R EZ/EM-1 H I e) B, A SRR N 5 i 4753k B
AE AR, W EE 2 EZ/EM-1 L) 8. W RS kA, BB R & NEC Electronics
A E AR .
(112)

Fs AR BB A Ak 2R

1 R

H AR5 T

—> Ox84 Hudl-(75 1 P U8 BT AT G AR 25 )4 B 2 OX00 (AMET ) B H bk R4 EZIEM-1 2 a3 #E
RIEH
TSE 5 N HARBE & HFE R LA EZIEM-1 5 HAR RS GRS 0L

2 H#Ar4h:  0.00MHz [NG]

CLKA $iAf R Sh I ] BETCVA IE W TAF
A B SR AL P A £

3 IRBh bR

(1) EZIEM-1 JEHi [ o
- K& TEHL5 USB 45, L& USB cable 5 EZ/EM-1 [{J&ERAE
— MG T A 0l RO BT Y. (EZ/EM-1 S8 ki USB Mk, )
FIFFRTAT YR, i [DUSR]4%4L
SR LA 5 an Bk & S BE R, I s LAt S 2 HL LK Windows.
(2) WA HD.
— 2 LLK OCD Checker AN AIN JH 8l, LA,
(3) USB IRENFEIT AT e AN REIE H BT
— AR DL K USB SRah 2 deffil, R ZER USB IR .
(4) VRS T RE AT 1L 28
— FHre keIl as.

7 1% 1D 1

HNIK) 1D ARAS
- HIAE XN HFR 3% 1D ARSI HLAE B .

8 BFS &I REPN N

TCVRAT R E I H &S
- WASCHRR. B AR AR SRS .

9 Rom it T4 (xxH) 4, W fas i 2 (xxH) 4l

Hbri 45 EZIEM-1 3l 4
— JRIAATRE R R AR RS RO A, B USB UNEh Bl AT AN IE W
R EER:, FH EHUT K Windows .
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(2/2)

e HEDAE B DU R A 3
10 5N RAM, 1 RAM, Hnk i .

W RAM JCiEAFHL,  H bR AT iR

- T HPRRA .
11 _Flash #:A4%i%, _Flash Get Info Error, _Flash Block Blank Check Error, _Flash B84,

_Flash £ 5 X45i%, _Flash BURIG4ER, _Flash 4R, AR,

G flash I &4

SRR R PR EREA M. HARR A TREBIR, B HbR k4.

12 Break Timeout, ERROR: SP Break Test, ERROR: Execute Break Test1, ERROR: SFR Access

Break Test, ERROR: Read Access Break Test1, ERROR: Read Access Break Test2, ERROR: Write
Access Break Test1, ERROR: Write Access Break Test2, ERROR: Step Break Test, ERROR:
Execute Break Test2

HAR e rT e OR, S He HAR B o
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fi3RB 30 K HI M HE

® NEC 4RI i % F0 NV Applilet T H R & st an
http://www.cn.necel.com/micro/cn/product/sc/applilet/applilet-freesoft.html
®  WriteEZ RAIAFI T E i T
http://www.cn.necel.com/en/Badge2007/flash _gui.html

® [T EZ/IEM-1 [f] NEC 4= R F kA hil a4 (1 1Bl 8 A 2k -
http://www.cn.necel.com/cn/Badge2007/debugger.html

® EZ/EM-1 [AF NI T
http://www.cn.necel.com/cn/Badge2007/modify2.html

® WA SRS ECCAT I T Ak
https://www5.necel.com/micro/tool reg/OdsListTop.do?lang=en

® badge /-4
http://www.cn.necel.com/cn/Badge2007/connections3.html
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